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Посвящается 

Сергею Юрьевичу Купчинаусу 

 

ПРЕДИСЛОВИЕ 

 

В учeбнo-мeтoдичecкoм пocoбии pacкpывaютcя различные 

cпocoбы coздaния графических изображений и таблиц в 

программе компьютерной вѐрстки Adobe InDesign, примеры 

верстки печатных объектов, советы, а также основные горячие 

клавиши, необходимые для более быстрой работы.  

Цeлью учeбнo-мeтoдичecкoгo пocoбия являeтcя 

фopмиpoвaниe у cтудeнтoв умeний paбoты c paзличными видaми 

инфopмaции, а также навыков работы с наилучшим 

профессиональным инструментом компьютерной верстки, 

применяемой для создания книг, журналов, газет и другой печатной 

продукции. 

Учeбнo-мeтoдичecкoe пocoбиe включает в себя 

тeopeтичecкую cocтaвляющую, входящую в алгоритм создания 

изображений, в кoтopoй oбъяcняютcя ocнoвныe тepмины, 

иcпoлняeмыe пpи выпoлнeнии пpaктичecких зaдaний, пoяcняютcя 

тeхнoлoгии и мeтoдичecкиe укaзaния, используемые для выпoлнeния 

упражнений.  

В дaннoм мeтoдичecкoм пособии дaны пpaктичecкиe зaдaния 

пo пpинципу «oт пpocтoгo к cлoжнoму». Авторы пособия 

подразумевают наличие теоретических основ работы с 

инструментами в Adobe InDesign. Мeтoдичecкoе pукoвoдcтво 

пpeдвapяeт ввeдeниe, кoтopoe oпpeдeляeт знaчeниe программы 

компьютерной вѐрстки Adobe InDesign в нacтoящee вpeмя. 

Вaжным мoмeнтoм являeтcя нaличиe в пocoбии cпиcкa литepaтуpы, 

знaкoмящeгo cтудeнтoв c нaибoлee знaчимыми и paзнooбpaзными 

иcтoчникaми инфopмaции.  

В приложении  даются контрольные вопросы по 

практической части и по теоретической части,  
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Нacтoящee пocoбиe пoмoжeт cтудeнтaм бaкaлaвpиaтa 

и мaгиcтpaтуpы в учeбнoм пpoцecce, в caмocтoятeльнoм oвлaдeнии 

знaниями и умeниями в oблacти компьютерной вѐрстки. 

Пocoбиe мoжeт быть peкoмeндoвaнo cтудeнтaм нaпpaвлeния 

пoдгoтoвки 51.03.06 «Библиoтeчнo-инфopмaциoннaя дeятeльнocть» 

при освоении дисциплины «Мультимедийные ресурсы библиотеки», 

09.03.03 «Пpиклaднaя инфopмaтикa в дизaйнe» при освоении 

дисциплины «Мультимедиа технологии», a тaкжe cтудeнтaм дpугих 

нaпpaвлeний для caмocтoятeльнoгo ocвoeния дaннoгo 

мультимeдийнoгo пpoдуктa. 

Пocoбиe пoмoжeт пoвыcить кaчecтвo учeбных зaнятий, лучшe 

пoдгoтoвитьcя к зaчeту или экзaмeну, будeт вocтpeбoвaнo нa 

пpaктикaх cтудeнтoв. 
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ВВЕДЕНИЕ 

 

Adobe InDesign – программа компьютерной вѐрстки 

(DTP), разработанная фирмой Adobe Systems. 

InDesign является следующей после PageMaker 

усовершенствованной программой вѐрстки. Adobe InDesign 

позволяет создавать документы для вывода их как на 

типографские машины промышленного уровня, так и на 

настольные принтеры, а также экспортировать созданные 

документы в различные форматы электронных изданий, в том 

числе PDF. Версии InDesign CS6 и выше имели улучшенную 

интеграцию с компонентами популярного пакета Adobe Creative 

Suite. Инсталляция официальной версии программы не 

требовала особых навыков. Начиная с версии CS3, интерфейс 

InDesign не подвергался кардинальным изменениям, так как 

основные функции программы не менялись. 

Adobe InDesign – мощное приложение, обеспечивающее 

точность, контроль и безупречную интеграцию с другими 

профессиональными графическими программами Adobe. 

Используя программное обеспечение InDesign, можно создавать 

полноцветные документы профессионального качества для 

печати на высокопроизводительных цветных печатных станках 

или широком диапазоне устройств вывода и форматов, включая 

настольные принтеры и устройства отображения с высоким 

разрешением. Adobe InDesign позволяет формировать 

динамические документы и экспортировать их как файлы Adobe 

Flash (с кнопками, гиперссылками и переходами между 

страницами) или файлы портативного формата документов 

(Portable Document Format, PDF) с закладками, гиперссылками, 

кнопками, фильмами и звуковыми роликами, а также 

преобразовывать документы для использования в Интернете, 

экспортируя макеты в XHTML или XML. Авторы, графики, 

дизайнеры и издатели смогут общаться с более широкой 

аудиторией с помощью очень большого количества средств и 

https://ru.wikipedia.org/wiki/Adobe_Systems
https://ru.wikipedia.org/wiki/PageMaker
https://ru.wikipedia.org/wiki/PDF
https://ru.wikipedia.org/wiki/Adobe_Creative_Suite
https://ru.wikipedia.org/wiki/Adobe_Creative_Suite
https://ru.wikipedia.org/wiki/%D0%98%D0%BD%D1%82%D0%B5%D1%80%D1%84%D0%B5%D0%B9%D1%81_(%D0%BF%D1%80%D0%BE%D0%B3%D1%80%D0%B0%D0%BC%D0%BC%D0%B8%D1%80%D0%BE%D0%B2%D0%B0%D0%BD%D0%B8%D0%B5)
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безупречной интеграции с другими компонентами Creative Suite 5. 

Программное обеспечение для настольных систем Adobe 

InDesign представляет собой универсальное приложение для 

публикации контента, которое обеспечивает точный контроль 

над дизайном и типографикой на уровне пикселов, создания 

стильных выразительных страниц для печати, планшетных ПК  

и других экранов. Удобная адаптация макетов к различным 

форматам страниц, ориентациям и устройствам с сохранением 

высокого качества изображения. 

Программа содержит инструменты для решения любых 

задач – от простейших бумажных проектов до сложных 

интерактивных электронных изданий, которые в последнее 

время все более и более востребованы. 
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СОЗДАНИЕ ТЕКСТОВЫХ ЭФФЕКТОВ 

 

Работа с текстом 

Текст в InDesign содержится в контейнерах, называемых 

текстовыми фреймами. 

Существует два типа текстовых фреймов: сетки 

фреймов и простые текстовые фреймы. Сетки фреймов – 

текстовые фреймы, предназначенные для компоновки текстов 

на азиатских языках, в которых шпации и интервал 

отображаются в виде сетки. Пустые текстовые фреймы, в 

которых не отображается сетка, называются простыми 

текстовыми фреймами. 

Как и графические фреймы, текстовые фреймы можно 

перемещать, изменять их размер и содержимое. Инструмент, с 

помощью которого выделяется текстовый фрейм, определяет 

тип изменений, которые могут быть в него внесены. 

Текстовый фрейм может быть соединен с другим 

текстовым фреймом, чтобы текст из одного фрейма мог 

перетекать в другой. Такие фреймы называются связанными. 

Текст, перетекающий по связанным фреймам, называется 

материалом. При помещении (импорте) текста из файла 

текстового процессора в документ, он остается единым 

материалом независимо от того, сколько займет фреймов. 

Текстовые фреймы могут содержать несколько колонок. 

Текстовые фреймы могут быть основаны на колонках, и в то же 

время быть независимыми от них. Другими словами, текстовый 

фрейм с двумя колонками может находиться на странице, 

разбитой на четыре колонки. Текстовый фрейм можно 

расположить на странице-шаблоне, по-прежнему использовать 

для развертки текста на странице документа. 

Если один и тот же тип текстового фрейма применяется 

постоянно, можно создать стиль объекта, включающий 

различные атрибуты форматирования – цвета обводки и 
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заливки, параметры текстового фрейма, эффекты обтекания 

текстом, прозрачности и другие. 

При помещении или вставке текста создание текстового 

фрейма необязательно. InDesign автоматически добавит фрейм в 

соответствии со значениями параметров колонок страницы. 

При вставке текста автоматически создается простой 

текстовый фрейм. Также можно создать пустой простой 

текстовый фрейм вручную и затем ввести текст. 

 

В этом разделе приведены примеры текстовых 

эффектов, которые можно выполнить, не обращаясь к 

Adobe Photoshop, и даны скриншоты настроечных 

параметров, отталкиваясь от которых, вы сможете 

получить свои, не менее интересные, варианты оформления 

текста. 

 

Упражнение 1. Оформление текста типа Strong 

 

Как вы знаете, эффекты прозрачности можно применять 

к обводке, заливке, к тексту или ко всему объекту (рис. 1). 

Рис. 1. Эффект прозрачности, примененный к объекту в целом 
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В примере оформления текста типа Strong эффект Bevel 

and Emboss (рис. 2) применен ко всему объекту. Размер шрифта 

– 80 pt. 

Рис. 2. Эффект Bevel and Emboss 

 

К символам применена линейная градиентная заливка 

с концевыми значениями 50% от Black. Обводка букв размером 

в 2 pt и цветом 70% от Black (рис. 3). 

Рис. 3. Текст типа Strong 

 

Упражнение 2. Оформление текста типа Shock 

 

В этом примере фрейм и символы в нем залиты синим 

цветом. Размер символов – 80 pt. Обводки у символов нет (рис. 4). 
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Рис. 4. Текст типа Shock 

 

 

Эффект Bevel and Emboss применен к тексту. Параметры 

эффекта на рис. 5. 

Рис. 5. Эффект Bevel and Emboss 
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Упражнение 3. Оформление текста типа Flash  

 

Здесь фрейм залит чѐрным цветом, к тексту применена 

линейная градиентная заливка с углом 92° и концевыми 

значениями 50% от Black. Обводка у букв в 2 pt цветом 70% 

от Black. Размер символов – 80 pt (рис. 6). 

Рис. 6. Текст типа Flash 

 

К тексту применено 3 эффекта: Outer Glow (рис. 7), 

Bevel and Emboss (рис. 8) и Satin (рис. 9). 

 

 

 

 

 

Рис. 7. Эффект Outer Glow 
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Рис. 8. Эффект Bevel and Emboss 

Рис. 9. Эффект Satin 

 

Упражнение 4. Оформление текста типа Ripple 

 

Фрейм залит цветом С=30, М=100, Y=0, K=50. Буквы 

размером 80 pt покрашены в цвет C=70, M=20, Y=50, K=20. 

Контур у букв размером 2 pt и такого же цвета, как и цвет 

фрейма (рис. 10). 
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Рис. 10. Текст типа Ripple 

 

К тексту примено три эффекта: Outer Glow (рис. 11), 

Bevel and Embos (рис. 12) и Gradient Feather (рис. 13) 

Рис. 11. Эффект Outer Glow 

Рис. 12. Эффект Bevel and Emboss 
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Рис. 13. Эффект Gradient Feather 

 

Упражнение 5. Оформление текста типа Wrapit 

 

Здесь размер шрифта 80 pt, буквы залиты темно-синим 

цветом С= 100, M=90, Y=10, K=0, обводки у символов нет (рис. 14). 

Рис. 14. Текст типа Wrapit 

 

 

Два эффекта прозрачности применены ко всему объекту 

(рис. 15, 16). 
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Рис. 15. Эффект Bevel and Emboss 

Рис. 16. Эффект Satin 

 

Упражнение 6. Оформление текста типа Grime  

 

Текст размером 80 pt темно-синего цвета без обводки 

(рис. 17). Фрейм не залит никаким цветом.  
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Рис. 17. Текст типа Crime 

 

Ко всему объекту применено 4 эффекта (рис. 18-21). 

Рис. 18. Эффект Drop Shadow 

Рис. 19. Эффект Inner Shadow 
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Рис. 20. Эффект Outer Glow 

Рис. 21. Эффект Directional Feather 

 

Упражнение 7. Создание теней 

 

Не забывайте, что созданное вами оригинальное 

оформление текста вы можете сохранить, как объектный стиль, 

что облегчит вам дальнейшее его использование. 

Длинные тени как бы добавляют объем вашему плоскому 

творению и хорошо передают ощущения чего-то значительного, 

важного (рис. 22). 

Нарисуйте графический фрейм такой величины, чтобы 

ваш текст поместился на его верхней стороне. 

Используя инструмент Type on a path tool (Shift+T) 

с нажатой левой клавишей протащите мышь по верхней стороне 

фрейма (с левого верхнего угла в правый верхний). 
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Рис. 22. Создание теней 

 

Нарисуйте графический фрейм такой величины, чтобы 

ваш текст поместился на его верхней стороне (рис. 23). 

Рис. 23. Графический фрейм 

 

Используя инструмент Type on a path tool (Shift+T) 

с нажатой левой клавишей протащите мышь по верхней стороне 

фрейма (с левого верхнего угла в правый верхний угол (рис. 24). 

Рис. 24. Графический фрейм 

 

Небольшие погрешности, которые у вас могли 

получиться, можно исправить с помощью белой стрелки 

(инструмент Direct Selection). 

Начинайте набирать ваш текст по верхней стороне 

фрейма (текст по пути) (рис. 25). Сделайте выравнивание текста 

по центру. 
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Используйте заглавные буквы. 

Не рекомендуется использовать шрифт с засечками, так 

как эффект будет хуже.  

Рис. 25. Текст на верхней стороне фрейма 

 

Выделите фрейм и убедитесь, что reference point 

является одной из трех верхних( ). 

С нажатой клавишей Alt щелкните по кнопке Flip 

vertical button  в Панели управления, чтобы получить 

вертикально перевернутую (отраженную) копию фрейма. 

Сейчас у нас два таких фрейма (рис. 26): 
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Рис. 26. Два графических фрейма 

 

Выделив новый фрейм выберите Type > Type on a Path 

Options и в появившемся окне выберите Gravity effect (рис. 27). 

Рис. 27. Gravity effect 
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Вы получите примерно такой результат (рис. 28): 

Рис. 28. Применение Gravity effect 

 

Подберите длину тени. Для этого выделите текст тени 

и в Панели управления измените значение вертикального 

размера  (рис. 29). 

 

Рис. 29. Подбор длины тени 

 

Уменьшая или увеличивая высоту отраженного фрейма, 

можно подобрать желаемый «разбег в стороны» тени (рис. 30). 
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Рис. 30. Регулирование ширины тени 

 

И, наконец, добавим исчезновение тени. Для этого 

используем эффект Directional Feather (рис. 31). 

Рис. 31. Эффект Directional Feather 

 

Вот так будет выглядеть конечный результат (рис. 32): 

Рис. 32. Конечный результат 
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Упражнение 8. Зеркальное отражение текста 

 

При зеркальном отражении (Flip) текстовых полигонов 

текст тоже становится зеркальным, что бывает неудобно. 

К примеру, мы нарисовали стрелку, указывающую 

вправо, и хотим получить точно такую же стрелку, но 

указывающую влево, и с другой надписью внутри. Применив 

команду Flip, мы получим такой результат (рис. 33): 

Рис. 33. Текст на стрелках 

 

Менять текст в таком варианте зеркальной копии не 

имеет смысла. Надо нарисовать новую стрелку или 

восстановить в ней правильное направление текста. 

Данная стрелка – достаточно простая фигура, и ее 

нетрудно нарисовать, но в практике могут встретиться более 

сложные текстовые полигоны, для которых оптимальным будет 

не их отрисовка, а изменение направления текста. 

Рассмотрим, как это можно сделать, на примере нашей 

стрелки. 

Рисуем маленький текстовый фрейм и применяем к нему 

такой же объектный стиль, как и у стрелки. Затем располагаем 

его над стрелкой (рис. 34). 

 

Рис. 34. Текст 

на стрелке 
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Выделяем стрелку и новый фрейм и применяем к ним 

команду Add из панели Pathfinder для получения одной 

фигуры (рис. 35). 

Рис. 35. Применение команды Add к стрелке и фрейму 

 

Результирующая фигура возьмет свойства верхнего 

объекта (нашего нового фрейма), в котором было правильное 

направление текста. 

Теперь в новую стрелку можно писать текст (рис. 36). 

Рис. 36. Текст на стрелке 
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Упражнение 9. Программа передач 

Рис. 37. Заголовок программы передач 

 

 

Основная трудность здесь заключается в скругленных 

углах по правому краю плашки (рис. 37). 

Для данной цели нужно будет использовать линии 

(Strokes).  

Непосредственными помощниками в реализации идеи 

будут стили абзаца и символа (Paragraph Styles и Character 

Styles) и те их свойства, которые позволяют работать с линейками: 

верхняя абзацная линейка (Rule Above) и подчеркивание 

(Underline). 

В исходниках мы имеем фрагмент телепрограммы 

и базовый стиль – 01_TV_Main, об основных параметрах 

которого можно судить по значениям в панелях Character, 

Paragraph и Tabs (рис. 38). 
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Рис. 38. Фрагмент телепрограммы 

 

 

 

На его основе создадим еще два стиля: для 

художественных фильмов (с плашкой Magenta, 100%) и для 

сериалов (с плашкой Cyan, 100%). Каждый такой стиль будет 

представлен двумя составляющими – стилем абзаца и соответствующим 

ему стилем символа, каждый из которых будет нести свою 

функциональную нагрузку. 
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В произвольном месте выделяем произвольный фрагмент 

времени передачи и вызываем палитру Character (Ctrl+M), 

а из нее – диалог Underline Options. Для того, чтобы визуально 

контролировать результат своих действий, активируйте опцию 

Preview (рис. 39). 

Рис. 39. Диалог Underline Options 

 

Толщина линии будет на 1 пункт меньше кегля 

основного текста, то есть, 7 pt. 

Тип линии – сплошная (Solid). 

Цвет линии на этом этапе можете задать любой – сейчас 

он для нас не имеет никакого значения, но с черным, который 

будет предложен вам по умолчанию, работать не очень удобно 

(т.к. цвет текстового выделения тоже черный). 

Для параметра Offset нужно вручную подобрать такое 

его значение, чтобы текст визуально располагался примерно 

посредине плашки, например, -2,75 pt (рис. 40). 
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Рис. 40. Настройка значений в Underline Options 

 

Записываем эти значения (они нам еще пригодятся), 

жмем ОК и переходим к следующему этапу. 

Здесь лучше ничего не выделять, а просто установить 

текстовый курсор в «подопытный» абзац. 

Теперь нам понадобится палитра Paragraph Rules 

(Ctrl+Alt+J). Активируем Preview для визуального контроля, и 

устанавливаем верхнюю абзацную линейку (Rule Above) (рис. 40): 
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Рис. 40. Палитра Paragraph Rules 

 

Устанавливаем толщину линии 7 pt, тип – японский 

пунктир (Japanese dots), отступ от левого края колонки (Left 

Indent) – 1 mm. Параметры Offset и Right Indent вам предстоит 

подобрать самостоятельно. В данном примере они получились -

0,27 мм и 28,4 мм, соответственно (рис. 41). 

Рис. 41. Paragraph Rules 
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Снова записываем параметры из диалогового окна 

и закрываем его. 

Присваиваем символьному стилю имя 02_TV_Film. 

Жмем Shift+F11, выбираем New Character Style (рис. 42). 

Рис. 42. New Character Style 

 

 Вкладка Basic Character Format 

 

Сюда мы переносим наш шрифт (HeliosCondC); но, 

в отличие от основного стиля, делаем его полужирным (Bold). 

Обязательно активируйте опцию подчеркивания текста 

(Underline). Все остальные значения можно перенести из основного 

стиля (рис. 43). 
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Рис. 43. Вкладка Basic Character Format 

 

 Вкладка Advanced Character Format 

 

Здесь в поле Language выберите [No Language] (рис. 44). 

Рис. 44. Вкладка Advanced Character Format 
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На вкладке Character Color выберите цвет символов – 

белый, без обводки (рис. 45). 

Рис. 45. Вкладка Character Color 

 

В окно вкладки Underline Options переносим значения, 

полученные в результате первого замера (рис. 46): 

Рис. 46. Вкладка Underline Options 
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Результат на рис. 47.  

Рис. 47. 

Переходим к созданию стиля абзаца. Вызываем палитру 

абзацных стилей (F11). 

Копируем основной стиль и переименовываем (по аналогии 

со стилем символа) в 02_TV_Film. Теперь нужно немного его 

подкорректировать. 

 

 Вкладка Basic Character Format 

  

Выставляем полужирное начертание (соответственно 

стилю символа). Обратите внимание, что в стиле абзаца 

подчеркивание не нужно (рис. 48). 

Рис. 48. Вкладка Basic Character Format. 
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 Вкладка Paragraph Rules. 

 

Сюда переносим данные, которые мы получили в результате 

второго «замера» (рис. 49): 

Рис. 49. Вкладка Paragraph Rules 

 

 Вкладка Drop Caps and Nested Styles 

 

Здесь мы объединим две составляющие нашей плашки 

в одно целое. Щелчком на кнопке New Nested Style создаем 

новое правило для вложенного стиля (рис. 50): 

Рис. 50. Вкладка Drop Caps and Nested Styles 
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И прописываем его (рис. 51): 

Промежуточный результат. Рис. 51. 

 

Остальные вкладки оставляем без изменений. 

Теперь можно проверить, как  работает наш стиль (рис. 52):  

Рис. 52. Созданный стиль 

http://sergei-kotob.ru/ids/-MAKEUP/038/screen_15.png
http://sergei-kotob.ru/ids/-MAKEUP/038/screen_16.png
http://sergei-kotob.ru/ids/-MAKEUP/038/screen_17.png
http://sergei-kotob.ru/ids/-MAKEUP/038/screen_15.png
http://sergei-kotob.ru/ids/-MAKEUP/038/screen_16.png
http://sergei-kotob.ru/ids/-MAKEUP/038/screen_17.png
http://sergei-kotob.ru/ids/-MAKEUP/038/screen_15.png
http://sergei-kotob.ru/ids/-MAKEUP/038/screen_16.png
http://sergei-kotob.ru/ids/-MAKEUP/038/screen_17.png
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Мы создали только один стиль – для художественных 

фильмов. С остальными (для сериалов, телепередач) все проще 

– нужно скопировать готовые стили символа и абзаца, 

переименовать, поменять цвет плашки и обязательно 

подправить символьный Nested Style. 

 

Упражнение 10. Выравнивание текста в двух колонках 

 

В этом упражнении выполним выравнивание строк 

текста в двух колонках. 

Для его выполнения потребуются небольшие 

графические изображения и любой текст. Вы так же можете 

использовать в тексте заголовки или буквицы, чтобы текст 

в разных колонках был смещен, как это показано на рис. 53. 

 

 

Рис. 53. Пример смещения текста в колонках из-за наличия 

графических изображений 
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Упражнение 11. Выравнивание текста 

 

1. Выберите команду File • New • Document (Файл • 

Создать • Документ). 

В диалоговом окне New Document (Новый документ) 

в разделе Columns (Колонки) введите значение 2. Остальные 

параметры документа оставьте установленными по умолчанию. 

2. Выберите инструмент Туре (Текст) и создайте им 

в верхней части страницы прямоугольный фрейм во всю 

ширину полосы набора. 

3. Из меню Object (Объект) вызовите диалоговое окно 

Text Frame Options (Параметры текстового фрейма) (рис. 54) 

и в разделе Columns (Колонки) введите значение 2. 

Рис. 54. Диалоговое окно Text Frame Options 
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4. В созданный фрейм введите текст таким образом, 

чтобы он занимал обе колонки. 

5. С помощью инструмента Zoom (Масштаб) увеличьте 

область страницы с текстовым фреймом. 

Подготовьте или используйте небольшие графические 

изображения для их вставки в текст. Работа с графикой будет 

подробно изучаться в дальнейшем. 

Если для вас это вызывает затруднение, выделите 

несколько символов текста в первой колонке и увеличьте их 

кегль. В примере использованы изображения размером 0,4x0,4 

см. 

6. Для вставки изображений в текст установите точку 

ввода в место вставки изображения и выполните команду File • 

Place (Файл • Поместить). 

7. Если графические изображения после размещения 

отображаются плашками, выполните команду View • Display 

Perfomance • High Quality Display (Вид • Настройка 

отображения • Вывод высокого качества). 

8. Включите отображение сетки базовых линий командой 

View • Grids & Guides • Show Baseline Grid (Вид • Сетки 

и направляющие линии • Показать сетку базовых линий). 

9. Если базовые линии не отобразились, увеличьте 

масштаб отображения документа с помощью инструмента Zoom 

(Масштаб) 

По умолчанию на палитре Control (Управление) включен 

режим Do not align to baseline grid (Без выравнивания по сетке 

базовых линий), поэтому вы, возможно, получите смещение 

строк в колонках, как показано на рис. 53., что выглядит 

некрасиво. 

10. Для привязки строк к сетке базовых линий командой 

Edit • Preferences (Правка • Установки) перейдите на вкладку 

Grids (Сетки) и настройте значение параметра Increment Every 

(Приращение). Его значение зависит от величины интерлиньяжа 
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текста, его кегля, а также размера графических изображений. 

В рассматриваемом примере было установлено значение 4 pt. 

11. Для выравнивания по сетке базовых линий нажмите 

кнопку Align to baseline grid (Выравнивание по сетке базовых 

линий). Пример выровненного текста приводится на рис. 55. 

Дополнительно был изменен интерлиньяж до значения 13 pt. 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 55 . Текст, выровненный по сетке базовых линий 

 

В заключение следует отметить, что при выравнивании 

настраиваются отбивки и интерлиньяж текста. Они становятся 

кратными интервалу сетки. 

 

Упражнение 12. Создание визитной карточки 

 

Выполним разметку визитной карточки, пример которой 

показан на рис. 56. 

Еще один учебный пример визитной карточки с графическим 

символом показан на рис. 57. 

1. Установите горизонтальные направляющие на высоте 

12, 26 и 46 мм, а вертикальные направляющие с координатами 

8 и 56 мм. 
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Рис. 56. Вид создаваемой визитной карточки 

Рис. 57. Пример простой визитной карточки 

2. Командой View • Grids & Guides • Lock Guides (Вид • 

Сетки и направляющие линии • Закрепить направляющие 
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линии) зафиксируйте направляющие линии от случайного 

перемещения. 

3. Командой View • Hide/Show Frame Edges (Вид • 

Спрятать/Показать границы фрейма) включите видимость 

границ фреймов. Эта функция при работе с текстом должна 

быть включена для контроля за количеством текстовых фреймов 

и их расположением. 

4. Выберите инструмент Туре (Текст) и создайте 

прямоугольный текстовый фрейм, начиная с пересечения левых 

вертикальной и горизонтальной направляющих для ввода 

верхней стоки с названием организации. 

5. При установленном в строке текстовом курсоре 

выберите подходящий шрифт, установите его кегль и введите 

название организации. В примере использован шрифт Comic 

Sans MS, Bold, кегль 14 pt, интерлиньяж 16,8 pt. 

6. Цифры 2/7 введены шрифтом Kozuka Mincho Pro, 

начертание Н, кегль 10. 

Число 2 отформатировано как верхний индекс, а 7 – как 

нижний индекс. 

Для этого выделите число 2 и на палитре Control 

(Управление) в режиме форматирования символов нажмите 

кнопку Superscript (Верхний индекс). 

Аналогичным образом с помощью кнопки Subscript 

(Нижний индекс) отформатируйте число 7. 

Дополнительно изменим величину кернинга между 

буквами «А» и «Т», а также ширину букв «И», т.к. в  нормальном 

написании они выглядят не совсем хорошо. 

7. Установите курсор между буквами «А» и «Т» и с помощью 

стрелок счетчика поля Kerning (Кернинг) установите подходящее 

значение кернинга. В примере оно равно -100. 

8. Для изменения ширины букв необходимо 

последовательно их выделить и установить требуемую ширину 

с помощью поля Horizontal Scale (Масштабирование по 
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горизонтали). В примере ширина буквы «И» изменена до 

значения 0,93, а ширина буквы «П» до значения 0,90. 

Теперь расположим название организации таким 

образом, чтобы базовая линия строки совпала с горизонтальной 

направляющей 12 mm. 

9. Выберите инструмент Selection (Выделение) и  щелкните 

им на границе фрейма, чтобы выделить фрейм. 

10. В меню View • Grids & Guides (Вид • Сетки и направляющие 

линии) командой Snap to Guides (Прилипание к направляющим линиям) 

включите притягивание к направляющим линиям. 

11. С помощью курсорных клавиш переместите 

выделенный фрейм вместе с текстом таким образом, чтобы 

базовая линия строки совпала с направляющей линией. 

12. Инструментом Туре (Текст) создайте текстовый 

фрейм для ввода фамилии и должности. Расположите фрейм 

таким образом, чтобы его середина располагалась 

приблизительно в положении горизонтальной направляющей 26 

mm. 

13. Введите фамилию и имя, затем нажмите клавишу 

<Enter> и введите должность. 

14. Отформатируйте фамилию подходящим шрифтом. 

Для этого установите текстовый курсор в любое место строки 

и назначьте подходящие параметры. 

В примере использован шрифт Complex, Bold, кегль 

10 pt, интерлиньяж 12 pt. 

15. Инструментом Selection (Выделение) выделите 

фрейм с фамилией и измените его ширину, переместив правую 

границу до положения последней буквы имени. Это условие 

будет использовано при выравнивании профессии. 

16. Отформатируйте название должности. В примере 

использован шрифт Arial, кегль 7 pt. Для создания разреженного 

теста с помощью кнопки Tracking (Трекинг) палитры Control 

(Управление) увеличьте интервал между символами. В примере 

было установлено значение трекинга, равное 290. С помощью 
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кнопки Align center (Выключка по центру) выровняйте 

название должности по центру фрейма. 

17. Расположите фрейм таким образом, чтобы базовая 

линия строки с фамилией совпадала с горизонтальной 

направляющей 26 mm. 

18. Аналогичным образом создайте текстовый фрейм и введите 

данные последних строк визитной карточки. В примере использован 

шрифт Arial Narrow, Regular, кегль 7 pt, интерлиньяж 8,4. 

19. Чтобы увидеть карточку в «первозданном» виде в меню 

View (Вид) отключите видимость направляющих линий и 

границ фреймов командами Grids & Guides • Hide Guides 

(Сетки и направляющие линии • Спрятать направляющие) и Hide 

Frame Edges (Спрятать границы фрейма). 

 

Упражнение 13. Трансформирование фрейма 

 

Простейшими операциями трансформирования фрейма 

являются изменение его ширины и высоты с помощью 

инструментов Select (Выделение) или Direct Selection 

(Частичное выделение) При этом параметры символов и абзацев 

не изменяются. В этом упражнении выполним различные 

операции трансформирования текстовых фреймов с помощью 

этих инструментов. 

1. Создайте новый документ и текстовый фрейм, 

заполненный текстом. Простейшим приемом, используемым 

в учебных целях, или при создании чернового варианта макета 

является использование команды Туре • Fill with Placeholder 

Text (Текст • Заполнить произвольным текстом). Для этого 

необходимо установить во фрейме точку ввода (в только что 

созданном фрейме точка ввода устанавливается автоматически) 

и выполнить названную команду, которая полностью заполняет 

фрейм случайным текстом. 

Причем каждый новый фрейм заполняется другим 

текстом. 
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Примечание. Если при вводе текста во фрейм текст 

выделяется цветом (подсвечивается), для отмены 

подсвечивания в диалоговом окне настроек, вызываемом 

командой Edit • Preferences (Правка • Установки) на вкладке 

Composition (Структура) в разделе Highlight (Подсветка), 

снимите флажок Substituted Fonts (Замененные шрифты). 

2. Выберите инструмент Select (Выделение) и щелкните 

им в любом месте внутри фрейма или на его границе, чтобы 

выделить фрейм (установить его текущим). 

Начнем упражнение с ситуации, когда фрейм не переполнен. 

Такая ситуация показана на рис. 58, слева. 

Рис. 58. Слева весь текст расположен внутри фрейма, 

справа – фрейм с переполнением 

 

3. Инструментом Zoom (Масштаб) увеличьте область 

страницы в месте расположения фрейма. 

Далее выполните следующие операции: 

4. Установите указатель инструмента Select (Выделение) 

внутри фрейма и перетащите его в новое место. Вместе с фреймом 

переместится и текст. 

5. Выполните перемещение фрейма при удержании 

клавиши <Alt>. В этом случае создается копия фрейма вместе 

со всем его содержимым. 

6. Подведите указатель инструмента Select (Выделение) 

к нижнему среднему маркеру и, когда он отобразится в виде 

разнонаправленной стрелки, нажмите кнопку мыши и  переместите 
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маркер вверх, для того чтобы уменьшить высоту фрейма. После 

перемещения маркера отпустите кнопку мыши. 

Так как после операции весь текст не поместился во 

фрейме, маркер выхода отобразится со знаком + красного цвета. 

7. Захватив за один из боковых маркеров, измените 

ширину фрейма. При этом текстовые строки изменяются, но 

текст остается читаемым. Пример показан на рис. 59, слева. 

Рис. 59. Трансформирование фрейма 

 

8. Угловые маркеры позволяют одновременно изменить 

ширину и высоту фрейма. Если при этом удерживать клавишу 

<Shift>, то происходит пропорциональное изменение ширины 

и высоты фрейма. Выполните такую операцию. Пример показан 

на рис., справа. 

9. Если за боковой маркер потянуть внутрь фрейма и далее 

за его противоположную границу, то происходит зеркальное 

отображение фрейма и текста. 

Пример приводится на рис. 60. 
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Рис. 60. Справа процесс отражения фрейма, 

слева – результат отражения 

 

Инструмент Direct Selection (Частичное выделение) 

позволяет выполнить следующие операции: 

• переместить фрейм, а также создать копию фрейма 

аналогично инструменту Select (Выделение) 

• дополнительно изменить форму содержимого фрейма 

произвольным образом, перемещая любой из угловых маркеров 

в произвольном направлении. При этом содержимое все равно 

вписывается в габаритный прямоугольник; 

• переместить любую границу фрейма, расположив на 

ней указатель инструмента. 

Содержимое также вписывается в габаритный 

прямоугольник. 

10. Щелкните инструментом Direct Selection (Частичное 

выделение) внутри фрейма или на его границе для выделения. 

Результат показан на рис. слева. При выделении отображаются 

только угловые маркеры уменьшенного размера. 

11. Захватите один из маркеров инструментом Direct 

Selection (Частичное выделение) и переместите его в произвольном 

направлении. 
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12. Захватите указателем одну из сторон фрейма и также 

переместите его в произвольном направлении. Результат 

показан на рис. 61, справа. При произвольном 

трансформировании фрейма параметры символов и абзацев не 

изменяются. 

Рис. 61. Слева фрейм, выделенный инструментом Direct 

Selection, справа – произвольное трансформирование фрейма 

 

Упражнение 14. Преобразование текста в кривые 

 

Для преобразования текста в кривые необходимо 

выполнить следующие операции: 

1. Выделить текстовый блок, намеченный для 

преобразования в кривые, инструментом Туре (Текст) Если 

необходимо преобразовать в кривые весь текст публикации, то 

следует использовать команду Edit • Select All (Правка • 

Выделить все) или комбинацию клавиш <Ctrl>+<A>. 

2, Выполнить команду Туре • Create Outlines (Текст • 

Преобразовать в кривые). 
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РАБОТА С ГРАФИКОЙ 

InDesign способен производить импорт файлов из 

большинства графических форматов. Проконсультируйтесь в 

типографии относительно формата, в котором следует 

сохранять документы. Это позволит организовать подготовку 

документов с использованием нужного формата и выбрать 

наиболее подходящие для данного проекта параметры. 

В следующей таблице перечислены все графические 

форматы, которые лучше всего подходят для работы с 

различными типами документов. 

Типографска

я печать 

Тип графики Формат 

Высокое 

разрешение 

(>1000 dpi) 

Векторные рисунки Illustrator, EPS, PDF 

Битовые 

изображения 

Photoshop, TIFF, EPS, PDF 

Триадное 

цветоделение 

Векторные рисунки Illustrator, EPS, PDF 

Цветные битовые 

изображения 

Photoshop, CMYK TIFF, 

DCS, EPS, PDF 

Графика, 

использующая 

систему управления 

цветом 

Illustrator, Photoshop, RGB 

TIFF, RGB EPS, PDF 

Печать с 

низким 

разрешением 

или PDF для 

просмотра 

через Интернет 

В полном объеме Любые (только 

изображения BMP) 

Web В полном объеме Любые (при экспорте в 

HTML графические 

объекты преобразуются в 

форматы JPEG и GIF) 
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 Сведения о векторных изображениях 

 

Векторные изображения (иногда называемые 

векторными фигурами или векторными объектами) состоят из 

линий и кривых, заданных векторами – математическими 

объектами, которые описывают изображение в соответствии 

с его геометрическими характеристиками (рис. 1). 

Векторные изображения можно свободно перемещать 

и изменять без потери детализации и четкости, поскольку такие 

изображения не зависят от разрешения. Их края остаются 

четкими при изменении размера, печати на принтере PostScript, 

сохранении в PDF-файле, а также при импорте в приложение 

для работы с векторной графикой. Таким образом, векторные 

изображения – это наилучший выбор для иллюстраций, которые 

выводятся на различные носители и размер которых приходится 

часто изменять, например логотипы. 

В качестве примера векторных изображений можно 

привести объекты, которые создаются в Adobe Creative Suite 

инструментами рисования и инструментами фигур. Копии 

векторных изображений в различных компонентах Creative Suite 

можно создавать с помощью команд «Копировать» и  «Вставить». 

Рис. 1. Пример растрового и векторного изображений 
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 Сведения о растровых изображениях 

 

В растровых изображениях для их представления 

используется прямоугольная сетка из элементов изображения 

(пикселов). Каждому пикселу соответствует определенное 

расположение и значение цвета. При работе с растровыми 

изображениями редактируются пикселы, а не объекты или 

фигуры. Растровые изображения – самый распространенный 

способ передачи таких нерастрированных изображений, как 

фотографии или цифровые рисунки, поскольку он позволяет 

наиболее эффективно передавать тонкие градации цвета и тонов. 

Растровые изображения зависят от разрешения, то есть 

они содержат фиксированное количество пикселов. При 

сильном увеличении на экране или при печати с разрешением 

ниже первоначального теряются детали, а края становятся 

неровными (рис. 2). 

Рис. 2. Пример растрового изображения с различной степенью 

увеличения 

 

Иногда для хранения растровых изображений требуется 

много места на диске, поэтому для уменьшения размера файлов 

при использовании в некоторых компонентах Creative 

Suite такие изображения часто требуют сжатия. Например, 
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перед импортом изображения в макет его сжимают в приложении, 

где оно было создано. 

Примечание. В Adobe Illustrator можно создавать 

графические растровые эффекты для рисунков с помощью 

эффектов и стилей графики. 

 

 Рекомендации по настройке разрешения изображения 

перед окончательным выводом 

 

Растровые изображения содержат фиксированное число 

пикселов, которое обычно измеряется в единицах ppi (пикселов 

на дюйм). Изображение с высоким разрешением содержит 

большее количество меньших по размеру пикселов, чем 

изображение тех же печатных размеров с меньшим разрешением. 

Например, изображение размером 1х1 дюйм с разрешением 72 ppi 

содержит 5184 пикселов (72 пиксела в ширину х 72 пиксела в высоту 

= 5184). Изображение того же размера (1х1 дюйм) с разрешением 

300 ppi будет содержать уже 90 000 пикселов. 

При импорте растровых изображений разрешение 

определяется исходным файлом. При использовании растровых 

эффектов можно задать другое разрешение. Для того чтобы 

определить разрешение, которое следует использовать, 

необходимо учесть конечный способ распространения 

изображения. Приведенные ниже рекомендации помогут 

определить требования к разрешению изображения. 

 Типографская печать 

В типографской печати используются изображения от 

150 до 300 и более ppi в зависимости от разрешения принтера 

(dpi) и линиатуры растра (lpi). Прежде чем принимать 

производственные решения, проконсультируйтесь с поставщиком 

услуг допечатной подготовки. Поскольку в типографской 

печати используются большие изображения с высоким 

разрешением, для отображения которых требуется больше 

времени, при подготовке макета часто используются их версии с более 
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низким разрешением, которые заменяются на первоначальные 

перед печатью. 

В приложениях Illustrator и InDesign можно работать с версиями 

изображений меньшего разрешения в палитре «Связи». В InDesign 

для этого нужно выбрать пункт «Стандартный» или «Быстрое 

отображение» в меню «Просмотр» > «Режим отображения». В Illustrator 

выберите «Просмотр» > «Контуры». Кроме того, изображения с низким 

разрешением можно получить от поставщика услуг, если он 

поддерживает открытый допечатный интерфейс (OPI). 

 Настольная печать 

Как правило, при настольной печати используются 

изображения от 72 ppi (для фотографий, которые выводятся на 

принтер с разрешением 300 ppi) до 150 ppi (для фотографий, 

которые выводятся на устройства с разрешением до 1000 ppi). 

При печати векторных объектов (1-битовых изображений) 

убедитесь, что разрешение изображений совпадает с разрешением 

принтера. 

 Веб-публикация 

Поскольку для публикации в Интернете обычно 

требуются изображения, которые должны умещаться на экране 

монитора, используются, как правило, рисунки не шире 500 

пикселов и не выше 400 пикселов, чтобы на экране оставалось 

достаточно места для элементов управления окна браузера или 

для различных элементов макета, например подписей. 

Изображения с экранным разрешением (96 ppi – для систем 

Windows и 72 - для систем Mac OS) выглядят примерно так же, 

как они будут выглядеть при просмотре через обычный веб-

браузер. При публикации в Интернете более высокое 

разрешение может понадобиться только в следующих случаях: 

если у пользователей должна быть возможность 

масштабировать изображения в документе PDF и если для 

документа с изображением должна поддерживаться печать по 

запросу. 
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 Добавление графических объектов в ячейки таблицы 

 

Вы можете воспользоваться программой InDesign для 

создания эффективных таблиц, объединяющих текст, 

фотографии и иллюстрации. Так как каждая ячейка, по сути, 

является небольшой рамкой для текста, то графические объекты 

будут добавляться путем привязки к тексту ячейки. Привязка 

графических объектов к ячейке может привести к переизбытку 

текста, обозначаемому красной точкой. Чтобы это исправить, 

достаточно раздвинуть границы ячейки, меняя тем самым ее 

размеры. 

В данном упражнении вы добавите значок в виде сердца 

напротив продуктов, полезных для сердца, и значок в виде 

бомбы напротив названий острых продуктов. 

1. Выполните команду View ⇒ Fit Page in Window 

(Просмотр ⇒ Подогнать под размер окна страницу). 

Красные значки сердца и бомбы появятся слева, в буфере 

обмена. 

2. Инструментом Selection (Выделение) выберите значок 

сердца в буфере обмена. При необходимости измените 

масштаб просмотра документа, чтобы видеть текст в таблице. 

3. Выполните команду меню Edit ⇒ Copy (Правка ⇒ 

Копировать). 

4. Переключитесь на инструмент Type (Текст) (двойной 

щелчок в любом месте таблицы также автоматически 

активирует данный инструмент). В первом столбце 

таблицы под надписью «Egg Type» щелкните возле слов 

«Whites Only» (Только белые) на второй строке. 

5. Нажмите клавишу Пробел, чтобы поставить пробел 

перед значком, а затем выполните команду Edit ⇒ Past 

(Правка ⇒ Вставить) (рис. 3).  
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Помимо добавления графических объектов в позиции 

текстового курсора, для импорта графических объектов 

можно также воспользоваться командой File ⇒ Place 

(Файл ⇒ Поместить), а затем выполнить привязку к ячейке 

таблицы. 

Рис. 3. Вставка графического объекта в строку таблицы 

 

6. Повторите шаги 4 и 5, чтобы поместить значки сердца 

возле надписи «Substitute» в столбце «Egg Type» и в ячейках 

со словами «Onions», «Mushrooms», «Jalapenos» и «Green 

Peppers» в столбце «Ingredients». 

7. Инструментом Selection (Выделение) выделите значок 

бомбы в буфере обмена, а затем выполните команду Edit 

⇒ Copy (Правка ⇒ Копировать). 
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8. Переключитесь на инструмент Type (Текст). Во втором 

столбце таблицы под надписью «Ingredients» щелкните 

возле значка сердца после «Jalapenos». 

9. Выполните команду меню Edit ⇒ Past (Правка ⇒ Вставить) 

(рис. 4). 

Рис. 4. Вставка значка бомбы 

 

10. Щелкните инструментом Selection (Выделение) по значкам 

сердца и бомбы, удерживая клавишу Shift; выполните 

команду Edit ⇒ Clear (Редактирование ⇒ Очистить) 

и сохраните документ. 
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Упражнение 1. Затенение части рисунка 

 

Выделите рисунок и на панели инструментов нажмите 

кнопку добавления эффектов. Выберите эффект Gradient 

Feather. 

Задайте 4 точки градиента: 

Первая точка – Location 0%, Opacity = 0% 

Вторая точка – Location 20% Opacity=100% 

Третья точка – Location 80%, Opacity=100% 

Четвертая точка – Location 100%, Opacity=0% 

Установите радиальный или линейный тип градиента. 

Если градиент линейный, то нужно задать угол: 0° или 90°. 

Нажмите ОК. 

Иногда требуется затенить часть рисунка, имитируя 

освещение направленным пучком света. Сделать это легко при 

помощи эффектов наложения (рис. 5). 

Рис. 5. Затенение краев рисунка 
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Упражнение 2. Создание рамки с уголками 

 

Создайте фрейм с нужным градиентом и с такими же 

размерами, как у выбранного вами рисунка и расположите его 

поверх рисунка.  

Откройте панель Effects и выберите для фрейма с градиентом 

режим наложения Multiply. С помощью движка Opacity подберите 

прозрачность (рис. 6). 

Рис. 6. Фрейм с уголками 

 

Способ базируется на использовании стиля линии – 

Stroke Styles. Есть небольшая особенность при создании этого 

стиля, которую мы сейчас и рассмотрим. 

Из меню панели Stroke выберите Stroke Styles, затем 

нажмите New. 

В открывшемся диалогом окне из выпадающего списка 

выберите тип линии – Dash.  

Установите параметр Pattern Length больше любого 

размера фрейма, который вы можете применить в своих 

работах, например, 3500 мм (рис. 7). 
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Рис. 7. Диалоговое окно создания стиля линии 

 

Параметр Length можно установить на свое усмотрение. 

Это длина стороны будущего уголка. 

Далее из выпадающего списка Сorners выберите 

параметр Adjust gaps. Нажмите ОК. 

 

Упражнение 3. Создание элементов управления 

Рис. 8. Элемент управления 
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Для создания элемента управления (рис. 8) нарисуйте 

черный круг (рис. 9). Скопируйте его в буфер обмена и выполните 

команду Edit > Paste in Place. 

Рис. 9. Черный круг 

 

Затем для нового круга установите Reference Point в верхнем 

ряду, по центру  и задайте в панели управления новые размеры 

– 70% по ширине и 50% по высоте (рис. 10). 

Рис. 10. Создание второго круга 
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Создайте градиентный образец черного цвета в пределах 

10-100% и смещением срединной точки ближе к светлому краю 

(рис. 11). 

Рис. 11. Создание градиента 

 

Заливаем овал созданным градиентом (рис. 12). 

Рис. 12. Заливка овала градиентом 
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Используя инструмент Градиент, сделаем правильную 

подсветку (тянем сверху вниз, удерживая Shift) (рис. 13). 

Рис. 13. Корректировка градиента 

 

Добавим остальные элементы. 

Установите Reference point в центр, скопируйте 

изначальный черный круг в буфер обмена, выполните команду 

Edit > Paste in Place и измените размеры копии, задав 40% по 

ширине и высоте от начальных размеров (рис. 14). 

Рис. 14. Создание уменьшенной копии черного круга 

 

Залейте маленький круг белым цветом. 

Используя инструмент Text, поставьте в этот круг цифру 

«8» нужным шрифтом. Зайдя в Text frame options, сделайте 

выравнивание по центру, задав сдвиг относительно базовой 

линии (рис. 15). 
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Рис. 15. Text Frame Options 

 

При помощи всего лишь трех элементов (рис. 16) наш 

шар выглядит достаточно реально, чтобы захотелось взять его 

в руки и встряхнуть (рис. 17). 

Рис. 16. Три элемента, из которых состоит шар 

Рис. 17. Конечный результат 
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В отличие от Adobe Photoshop и Adobe Illustrator, у программы 

Adobe InDesign нет образцов для заполнения какой-либо 

области повторяющимся шаблоном. Но в нем достаточно просто 

самому сделать такие элементы и размножить их, применяя 

процедуру Step and Repeat. 

Найдите или создайте элемент (далее – паттерн-объект), 

который вы хотите размножить (рис. 18). 

Паттерн (англ. pattern) (в комп. графике) – название для 

повторяющегося узора, орнамента, заполняющего плоскость 

или замкнутую фигуру. 

Рис. 18. Паттерн-объект 

 

Паттерн-объектом может быть линия, фотография, 

текстовый фрейм с каким-либо текстом и пр. Необходимо 

помнить, что готовый узор может серьезно увеличить время 

прорисовки на экране вашей страницы, поэтому отображение 

его в высоком качестве (High Quality Display) включайте только 

тогда, когда действительно нуждаетесь в этом. 

Разместите копии паттерн-объекта по углам основного, 

как показано на рисунке 19. Нарисуйте также центральный 

прямоугольник, охватывающий части угловых паттерн-

объектов: 
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Рис. 19. Копии паттерн-объекта 

 

Все маркеры объектов должны идеально совпадать друг 

с другом. Умные направляющие (Smart Guides) в InDesign 

помогут в этом (рис. 20). 

Рис. 20. Умные направляющие (Smart Guides) 
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Вы можете использовать различные объекты в центре, но 

такие же объекты должны быть и в углах. 

Сгруппируйте паттерн-объекты (исключая центральный 

прямоугольник) (рис. 21). 

Рис. 21. Сгруппированные паттерн-объекты 

 

Переместите сгруппированные паттерны в центральный 

прямоугольник (выделите группу паттернов, Edit > Cut, 

выделите центральный прямоугольник, Edit > Paste Into) (рис. 22). 

Рис. 22. Сгруппированные паттерны в центральном 

прямоугольнике 
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Мы получили образец паттерна. Выделив его 

инструментом Selection (черная стрелка), вы можете добавить 

ему фоновый цвет. Если вы решите изменить вид отдельного 

паттерн-объекта – выделяйте его белой стрелкой. Выбрать все 

паттерн-объекты в прямоугольнике можно при помощи кнопки 

в панели управления Select Content. 

 Затем можно поиграть с цветом и эффектами, но будьте 

осторожны с тенями и светами – они могут обрезаться (рис. 23). 

Рис. 23. Подбор цвета 

 

Чтобы заполнить образцом какую-то область, выберите 

из меню Edit > Step and Repeat. Поставьте галочку Preview. 

Установите параметр Vertical Оffset в ноль, а Нorizontal Оffset 

равным горизонтальному размеру нашего образца (рис. 24). 

Рис. 24. Заполнение паттерн-объектом области по горизонтали 
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Нажмите OK. Затем выделите весь прямоугольник 

и запустите операцию Step and Repeat снова, устанавливая 

Vertical Offset равным высоте паттерн-образца, а Нorizontal 

Оffset – ноль (рис. 25). 

Рис. 25. Готовое изображение с заполнением паттерн-объектом 

всей области 

 

Вы могли бы обойтись без паттерн-образца, используя 

только Step and Repeat, чтобы заполнить какую-то область. Но 

все же использование образца является менее громоздким, чем 

большое количество несвязанных объектов. 

Можно поместить паттерн-образец в библиотеку и использовать 

его по мере необходимости или сохранить как Snippet. 
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Упражнение 4. Создание угловых объемных узоров  

 

Начните с квадратного фрейма. Выберите Object > 

Corner Options, Inverse Rounded. Установите желаемый 

размер. Хорошее решение – выбрать его равным одной третьей 

от стороны квадрата (рис. 26). 

Рис. 26. Фрейм 

 

Выберите Edit > Step and Repeat и установите 

Horizontal Offset равным стороне квадрата и Vertical Offset 

в ноль. Установите желаемое количество повторений Repeat 

Count. Нажмите OK (рис. 27). 

Рис. 27. Функция Step and Repeat 
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Выделите все квадраты и снова вызовите функцию Step 

and Repeat. Установите Vertical offset равным высоте квадрата 

и Нorizontal offset в ноль. Нажмите OK (рис. 28). 

Рис. 28. Функция Step and Repeat 

 

Если вы хотите применить эффект, подобный Bevel and 

Emboss, нужно сначала соединить квадраты. Выделите их 

и выполните команду Object > Pathfinder > Add (рис. 29, 30). 



 

72 

 

Рис. 29. Заготовка 

Рис. 30. Готовый объект 

 

Если вы хотите получить плиточную структуру, 

примените эффект Bevel and Emboss (рис. 31). 
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Рис. 31. Плиточная структура 

 

Используйте для точного задания координат Панель 

управления, а не мышь. Экспериментируйте для наработки 

навыков и скоро поймете, что совсем не обязательно 

располагать паттерн-объекты по углам. Взяв за основу 

единственный космический корабль (рис. 32): 

Рис. 32. Образец объекта 
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Вы сможете создать мощный флот вторжения (рис. 33)!  

Рис. 33. Паттерн-объекты 

 

При помощи скрипта можно рисовать красивые розетки, 

как на рисунке ниже. В диалоговом окне задаются необходимые 

параметры – радиусы, плотность, количество повторений. 

Фигуру можно создавать как в текущем файле, так и в новом. 

Толщина линий по умолчанию – 0,1 pt (рис. 34). 

Рис. 34. Розетка, созданная с помощью скрипта 



 

75 

 

И еще такие фигуры (рис. 35): 

Рис. 35. Фигуры, созданные с помощью скрипта 

 

Ограничение: в поля диалога нельзя вводить дробные 

числа. 

Скрипт можно найти в интернете на сайтах по InDesign. 
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РАБОТА С ТАБЛИЦАМИ 

 

Adobe InDesign обладает достаточно развитыми 

инструментами работы с таблицами, что позволяет включать 

таблицы в текст документа подобно тому, как это происходит 

в Microsoft Word. Более того, импортируя документ Microsoft 

Word, содержащий таблицы, программа может распознать 

таблицу и превратить ее в понятный и редактируемый объект 

InDesign. Это позволяет редактировать внешний вид и содержимое 

таблицы, не покидая программу Adobe InDesign и не тратя лишнего 

времени и усилий на редактирование в других программах и импорт 

таблицы в документ. Работой с таблицами в Adobe InDesign 

занимается целое меню Table (Таблица). 

Вставить таблицу в текстовый контейнер можно с помощью 

команды Table > Insert Table (Таблица > Вставить таблицу). 

При этом в диалоговом окне вы можете указать основные 

параметры таблицы (рис. 1). 

 

Рис. 1. Диалоговое окно создания новой таблицы 

 

Поля Body Rows (Строки таблицы) и Columns (Столбцы) 

позволяют установить количество строк и столбцов таблицы. 
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Поля Header Rows (Шапка таблицы) и Footer Rows (Итоговые 

строки) позволяют создать строки с заголовками колонок 

(шапку) и итоговые строки, где мы можем, например, 

просуммировать числа в таблице. 

При вставке таблицы к ней можно применить один из 

созданных в InDesign стилей – с помощью значений из 

списка Table Style (Стиль таблицы). 

Другой способ создать таблицу – преобразовать в нее 

текст с разделителями. Для этого необходимо выделить текст, 

который необходимо превратить в таблицу и воспользоваться 

командой Table > Convert Text to Table (Таблица > Превратить 

текст в таблицу). 

В диалоговом окне указываются знаки, разделяющие 

будущие ячейки таблицы. В примере, приведенном на рис. 2, 

ячейки разделяются запятыми, а строки – концом абзаца, то есть 

уже находятся в разных строках текста. Таким образом, текст 

формата «1, 2, 3» будет преобразован в три ячейки с отдельными 

цифрами. 

Рис. 2. Диалоговое окно Convert Text to Table  

(Превратить текст в таблицу) 

 

В полях можно выбрать не только уже существующие 

значения, но и ввести любой желаемый символ. Если указать 

одинаковые символы для разделения строк и столбцов, нужно 
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дополнительно ввести значение в поле Number of Columns 

(Количество столбцов), указав количество столбцов в будущей 

таблице. 

Подобным же образом можно преобразовать таблицу в 

текст, воспользовавшись командой Table > Convert Table to 

Text (Таблица > Превратить таблицу в текст). 

Редактирование созданной (либо импортированной из 

документов формата RTF или DOC) таблицы осуществляется 

с помощью меню. Команды подменю Table > Insert Table 

(Таблица > Вставить) > Delete (Таблица > Удалить) дают 

возможность добавлять и удалять строки и столбцы, подменю 

Table > Select (Таблица > Выделить) позволяет легко выделить 

ячейку, строку или часть таблицы, чтобы изменить оформление. 

В уже созданной таблице можно разделять и объединять ячейки 

с помощью команд Merge Cells (Объединить ячейки), Unmerge 

Cells (Отменить объединение ячеек), Split Cells Vertically 

(Разделить ячейки вертикально), Split Cells Horizontally 

(Разделить ячейки горизонтально). Настроить созданную 

таблицу можно и с помощью палитры Table (Таблица) (рис. 3). 

Рис. 3. Палитра Table (Таблица) 

 

Оформить таблицу (толщину, цвет и стиль линий, 

заливку) можно вручную – выделив ячейки и настроив их 
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с помощью палитр Stroke (Абрис) и Swatches (Образцы цвета). 

Adobe InDesign предлагает механизмы настройки таблицы, 

которые позволят легко и быстро установить параметры даже 

очень большой таблицы. 

Команда Table > Table Options > Table Setup (Таблица > 

Настройки таблицы > Параметры таблицы) вызывает 

диалоговое окно настройки таблицы (рис. 4). Это окно содержит 

несколько отдельных вкладок, которые могут быть вызваны 

сразу другими командами подменю Table > Table Options 

(Таблица > Настройки таблицы). Настройки, приведенные 

в этом диалоговом окне, частично дублируются на палитре 

Table (Таблица). 

Рис. 4. Диалоговое окно Table Options (Настройки таблицы), 

вкладка Table Setup (Параметры таблицы) 
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На вкладке Table Setup (Параметры таблицы) можно 

изменить количество строк и столбцов, которое мы указали при 

создании таблицы и настроить основные параметры ее 

отображения. 

Настройки из области Table Dimensions (Размеры 

таблицы) позволяют указать количество столбцов и колонок, 

а также количество строк шапки таблицы и количество 

итоговых строк. 

В области Table Border (Рамка таблицы) мы можем 

установить параметры линии, которая очерчивает таблицу. 

Линии, разделяющие таблицу на ячейки, могут быть 

установлены отдельно – эта группа настроек заведует только 

прямоугольной рамкой вокруг всей таблицы. Настройки данной 

группы хорошо знакомы нам по теме настроек абриса объектов. 

Настройки из области Table Spacing (Отбивки таблицы) 

позволяют управлять  таблицы от текста. Поле Space Before 

(Отбивка перед) позволяет установить отбивку от 

предшествующего таблице абзаца, а поле Space After (Отбивка 

после) – отбивку от абзаца, следующего за таблицей. 

Раскрывающийся список Draw (Рисовать) из области 

Stroke Drawing Order (Порядок рисования линий) управляет 

тем, как будут рисоваться линии, разграничивающие ячейки 

таблицы. Список содержит следующие значения: Best Joins 

(Оптимальные соединения), Row Strokes in Front 

(Горизонтальные линии вверху), Column Strokes in Front 

(Вертикальные линии вверху). Эти настройки мало влияют на 

внешний вид таблицы и в большей степени касаются вопросов 

технической реализации рамок. 

Вкладка Row Strokes (Горизонтальные линии) содержит 

настройки, позволяющие управлять внешним видом 

горизонтальных линий, разграничивающих ячейки (рис. 5). Эту 

вкладку следует использовать в первую очередь, если 

необходимо внести «разнообразие» в расчерчиваемую таблицу. 
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Рис. 5. Диалоговое окно Table Options (Настройки таблицы), 

вкладка Row Strokes (Горизонтальные линии) 

 

Раскрывающийсясписок Alternating Pattern (Чередовани

е) позволяет установить правила, согласно которым будет 

расчерчиваться таблица. Область Alternating (Чередовать) 

содержит две идентичные группы настроек (слева и справа), 

устанавливающие параметры двух типов линий, которые будут 

использованы. 

В зависимости от того, какие настройки будут 

выполнены в области Alternating (Чередовать) и какое значение 

в списке Alternating Pattern (Чередование) мы выберем, 

горизонтальные линии таблицы будут выглядеть по-разному. 
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Список Alternating Pattern (Чередование) содержит 

значения: 

• None (Не чередовать) – все горизонтальные линии 

выглядят одинаково; 

• Every Other Row (Через одну) – два разных типа 

горизонтальных линий используются поочередно; 

• Every Second Row (Через две) – два разных типа линий 

используются поочередно, один из них используется каждый 

третий раз; 

• Every Third Row (Через три) – два разных типа линий 

будут используются поочередно, один из них 

используется каждый четвертый раз; 

• Custom Row (Заказной) – это значение высвечивается, 

когда порядок чередования установлен вручную. 

Поля First … Rows (Первые … линий) и Next … 

Rows (Последующие … линий) могут быть использованы для 

создания заказного порядка чередования. К примеру, установив 

в этих полях цифры «2» и «5», можно создать настройку, при 

которой первые две линии будут, например, тонкими (согласно 

левой группе настроек), затем последуют пять толстых линий 

(согласно правой группе настроек), затем снова две тонкие и т. д. 

Поля Skip First … Rows (Пропустить первые … линий) 

и Skip Last … Rows (Пропустить последние … линий) 

позволяют настроить исключения: например, не чередовать 

линии разных типов для первых десяти и последних трех строк 

таблицы. 

Установленный флажок Preserve Local Formatting (Сохранять 

индивидуальное форматирование), запрещает изменять 

оформления тех ячеек, строк и столбцов таблицы, которые были 

оформлены вручную. 

Настройки линий, используемых для разграничивания 

таблицы, идентичны настройкам абриса. 
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Вкладка Column Strokes (Вертикальные линии) (рис. 6) 

практически совпадает с предыдущей, однако здесь нужно 

установить параметры оформления вертикальных линий. 

Соответственно, все слова «Row» (строки, или горизонтальные 

линии) заменяются словами «Column» (столбцы, или 

вертикальные линии). 

Рис. 6. Диалоговое окно Table Options (Настройки таблицы), 

вкладка Column Strokes (Вертикальные линии) 

 

На вкладке Fills (Заливка) (рис. 7) можно настроить 

чередование окраски ячеек (цветного фона), подкладываемого под 

текст. Раскрывающийся список Alternating Pattern (Чередование) 

содержит типичные схемы чередования как строк, так и столбцов. 

Таким образом, можно окрасить столбцы или строки 

в различном порядке в разные цвета. 
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Рис. 7. Диалоговое окно Table Options (Настройки таблицы), 

вкладка Fills (Заливка) 

 

Нельзя установить одновременное чередование как 

строк, так и столбцов, поэтому автоматически раскрасить 

таблицу как шахматную доску не удастся. 

На вкладке Headers and Footers (Шапка и итоговые 

строки) (рис. 8) устанавливаются настройки отображения шапки 

и итоговых строк таблицы. 

Рис. 8. Диалоговое окно Table Options (Настройки таблицы), 

вкладка Headers and Footers (Шапка и итоговые строки) 
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В области Table Dimensions (Размеры таблицы) задается 

количество строк шапки (Header Rows) и количество итоговых 

строк (Footer Rows). 

Области Header (Шапка) и Footer (Итоговые строки) 

содержат специфические настройки отображения служебных 

строк таблицы. 

Раскрывающийся список Repeat Header (Повторять 

шапку) в области Header (Шапка) содержит значения, которые 

устанавливают повторение шапки таблицы: 

• в каждой колонке фрейма: Every Text Column (Каждую 

колонку); 

• в каждом новом фрейме: Once per Frame (Каждый 

фрейм); 

• на каждой новой странице: Once per Page (Каждую 

страницу). 

Эти настройки будут задействованы только в том случае, 

если таблица разрывается на отдельные колонки, фреймы или 

переносится на новые страницы. В таком случае действительно 

может быть важно повторять шапку таблицы, чтобы читатель 

мог сориентироваться в данных ячеек. 

Аналогичные настройки содержатся и в 

области Footer (Итоговые строки), только они касаются 

повторения итоговых строк таблицы. Как правило, повторять 

принято шапку таблицы на каждой странице или в каждой 

колонке, однако итоговые строки принято писать только в конце. 

При установленных флажках Skip First (Пропустить 

первую) и Skip Last (Пропустить последние) не будут 

отображаться соответственно шапка таблицы в первой колонке, 

в первом фрейме или на первой странице и итоговые строки 

в последней колонке, в последнем фрейме или на последней 

странице. 

Выполнив команду Table > Cell Options > Text  (Табл

ица > Настройки ячеек > Текст), мы вызовем диалоговое окно 

настройки ячеек (рис. 9). Оно содержит несколько отдельных 
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вкладок, которые могут быть сразу вызваны другими 

командами подменюTable > Cell Options (Таблица > Настройки 

ячеек). К этому диалоговому окну мы можем обращаться, если 

хотим установить параметры отображения одной или 

нескольких ячеек. Настройки, приведенные в этом диалоговом 

окне, частично дублируются на палитре Table (Таблица). 

Рис. 9. Диалоговое окно Cell Options (Настройки ячеек), 

вкладка Text (Текст) 

 

В области Cell Insets (Отступы в ячейке) можно 

установить отступ между границами ячейки и ее содержимым.  

Поля Top (Верхний), Bottom (Нижний), Left (Левый) 

и Right (Правый) позволяют задать разные отступы для всех 

четырех границ ячейки. 
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Настройки из области Vertical Justification 

(Вертикальное распределение) управляют положением текста в 

ячейке в том случае, если высота ячейки больше, чем высота 

строк текста. Раскрывающийся список Align (Выровнять) 

содержит значения Align Top (Вверх),Align Center (По центру), 

Align Bottom (Вниз) и Justify Vertically (Растянуть по высоте). 

Поле Paragraph Spacing Limit (Предельное расстояние между 

абзацами) позволяет выставить ограничение на увеличение 

расстояния при растягивании по высоте. 

В области First Baseline (Первая базовая линия) можно 

определить положение первой строки текста относительно 

таблицы. Раскрывающийся список Offset (Смещение) содержит 

следующие значения: 

• Ascent (Выносные элементы) – верхние выносные 

элементы букв всегда будут помещаться внутри ячейки; 

• Cap Height (Высота заглавных букв) – заглавные буквы 

всегда будут помещаться внутри ячейки; 

• Leading (Интерлиньяж) – расстояние между базовой 

линией первой строки и границей ячейки всегда равно величине 

интерлиньяжа; 

• x Height (Высота строчной буквы «х») – расстояние 

между базовой линией первой строки и границей ячейки равно 

высоте строчных букв без учета выносных элементов и 

диакритических знаков; 

• Fixed (Фиксированное) – расстояние между базовой 

линией первой строки и границей ячейки равно значению в поле 

Min (Минимум). 

Установленный флажок Clip Contents to Cell (Срезать 

содержимое ячейки) в области Clipping (Срезание) позволяет не 

растягивать ячейку, если содержимое не помещается в нее, 

а «срезать» часть содержимого, не отображая его. 

Раскрывающийся список Rotation (Поворот) в области 

Text Rotation (Поворот текста) позволяет установить 

направление, в котором будет вводиться текст в ячейке. 
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На вкладке Strokes and Fills (Линии и заливка) (рис. 10) 

можно установить индивидуальное оформление ячеек. Выбирая 

с помощью мыши линии вокруг ячейки (в окошке в верхней 

части диалогового окна), можно установить уникальные 

параметры линии для каждой из четырех сторон ячейки. 

Рис. 10. Диалоговое окно Cell Options (Настройки ячеек), 

вкладка Strokes and Fill (Линии и заливка) 
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Аналогично настройки из области Cell Fill (Заливка 

ячейки) могут быть использованы, чтобы окрасить ячейку 

в какой-нибудь цвет. 

Вкладка Rows and Columns (Строки и столбцы) (рис. 11) 

используется для настройки ширины столбцов и высоты строк. 

Поскольку все ячейки в столбце должны быть одинаковой 

ширины, а все ячейки строки одинаковой высоты, то, изменяя 

высоту или ширину одной ячейки, вы можете воздействовать на 

все ячейки строки или столбца соответственно. 

Рис. 11. Диалоговое окно Cell Options (Настройки ячеек), 

вкладка Rows and Columns (Строки и столбцы). 
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Раскрывающийся список Row Height (Высота строки) 

содержит два значения: At Least (Минимум) и Exactly (Точное 

значение). В зависимости от выбора можно установить 

минимальную или точно заданную высоту в поле справа от 

списка. Поле Maximum (Максимум) задает ограничение на 

увеличение высоты ячейки, если содержимое не помещается 

в ней. 

Поле Column Width (Ширина столбца) позволяет 

изменить ширину ячейки (а следовательно, и столбца, в котором 

она располагается). 

Настройки из области Keep Options (Настройки 

удержания) управляют тем, можно ли разрывать таблицу на 

данной строке, чтобы перенести остаток таблицы в другую 

колонку, в другой фрейм или на другую страницу. 

Раскрывающийся список Start Row (Начинать строку) 

управляет тем, где может находиться данная строка таблицы. 

Список имеет значения Anywhere (Где угодно), In Next Column 

(В новой колонке), In Next Frame (В новом фрейме), On Next 

Page (На следующей странице), On Next Odd Page (На 

следующей нечетной странице), On Next Even Page (На 

следующей четной странице). 

Флажок Keep with Next Row (Удерживать следующую 

строку) позволяет запретить отрывать данную строку таблицы 

от следующей за ней. 

С помощью настроек вкладки Diagonal Lines 

(Диагональные линии) (рис. 12) можно перечеркнуть какую-

либо ячейку диагональной линией (это делается, чтобы 

показать, что в данной ячейке нет и не должно быть 

содержимого). Четыре кнопки в верхней части окна позволяют 

выбрать один из видов перечеркивания (одной или двумя 

линиями) или отменить его. Настройки в области Line Stroke 

(Линия) позволяют установить параметры линии, используемой 

для создания перечеркивания. 
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Рис. 12. Диалоговое окно Cell Options (Настройки ячеек), 

вкладка Diagonal Lines (Диагональные линии) 

 

Упражнение 1. Создание и применение стиля ячейки 

и таблицы 

 

Для быстрого и правильного применения 

форматирования к таблицам можно создать стиль таблицы и 

стиль ячейки. Стиль таблицы применяется ко всей таблице, а 

стиль ячейки может быть применен к выбранным ячейкам, 

строкам и столбцам. Мы создадим стиль таблицы и стиль 

ячейки, чтобы быстро применить форматирование к другим 

видам меню. 
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 Создание стилей таблицы и ячейки 

В данном упражнении мы создадим стиль таблицы для 

простого редактирования таблицы и стиль ячейки для 

редактирования строк заголовка. 

11. Инструментом Type (Текст) щелкните по любой части 

таблицы. 

12. Выполните команду Window ⇒ Styles ⇒ Table Styles 

(Окно ⇒ Стили ⇒ Стили таблиц). 

13. В меню палитры Table Styles (Стили таблиц) отметьте 

пункт New Table Style (Новый стиль таблицы) (рис. 13). 

 

Рис. 13. Пункт New Table Stule палитры Table Styles 

 

14. Введите текст «Menu Tables» в поле Style Name (Имя 

стиля). Перейдите в раздел Table Setup (Настройка 

таблицы) в списке слева, чтобы увидеть, что настройки в 

группе Table Border (Рамка вокруг таблицы) заданы 

согласно выбранной таблице (рис. 14). 
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Рис. 14. Раздел Table Setup 

 

15. Щелкните по кнопке ОК. Новый стиль появится в 

палитре Table Styles (Стили таблиц). 

16. Активируйте инструмент Type (Текст) и щелкните по 

любой позиции строки заголовка. 

17. Выполните команду Window ⇒ Styles ⇒ Cell Styles 

(Окно ⇒ Стили ⇒ Стили ячеек). 

18. В меню палитры Cell Styles (Стили ячеек) отметьте 

пункт New Cell Style (Новый стиль ячейки) (рис. 15). 

 

 

Рис. 15. Пункт New Cell Style 
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19. Введите текст «Header Rows» в поле Style Name (Имя 

стиля). 

Сейчас мы установим другой стиль абзаца для текста в 

ячейках, к которым будет применяться стиль Header 

Rows. 

20. В раскрывающемся списке Paragraph Style (Стиль 

абзаца) выберите стиль Table Header. Данный стиль 

абзаца уже применен к тексту в строках заголовка (рис. 16). 

Рис. 16. Стиль Table Header 

 

21. Щелкните по кнопке OK. Новый слой появится в 

палитре Cell Styles (Стили ячеек). 

22. Выполните команду меню File ⇒ Save (Файл ⇒ 

Сохранить). 
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 Применение стилей таблицы и ячейки 

 

Теперь мы применим созданные стили к таблице. Чтобы 

позже основательно переделать вид таблицы, вам останется 

лишь подправить созданные ранее стили таблицы или ячейки. 

1. Используя инструмент Type (Текст), щелкните по любому 

месту в таблице. 

2. Щелкните по стилю Menu Tables в палитре Table Styles 

(Стили таблиц). 

3. Инструментом Type (Текст) перетащите стиль на 

выделенные строки заголовка (первые две строки) таблицы. 

4. Щелкните по стилю Header Rows в палитре Cell Styles 

(Стили ячеек ) (рис. 17). 

Рис.17. Стиль Header Rows 

 

5. Сбросьте выделение, выполните команду View ⇒ Fit 

Page In Window (Просмотр ⇒ Подогнать под размер 

окна страницу), а затем сохраните документ. 

 

 Завершение 

 

В качестве заключительного шага мы просмотрим меню в его 

текущем состоянии. Можно добавить ингредиенты и прочие детали 

позже. 

1. В нижней части панели Tools (Инструменты) отметьте 

пункт Preview (Предварительный просмотр) в 

раскрывающемся списке (рис. 18). 
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Рис. 18. Пункт Preview 

 

2. Нажмите клавишу Tab, чтобы скрыть все палитры и просмотреть 

результаты работы. 

 

Самостоятельная работа 

 

Вы освоили основы работы с таблицами в InDesign и можете 

поэкспериментировать с другими техниками построения таблиц. 

1. Для начала создайте новый документ. Размер страницы и 

прочие настройки не имеют значения. Для создания 

новой таблицы добавьте новый текстовый фрейм 

инструментом Type (Текст) . Затем выполните команду 

меню Table ⇒ Insert Table (Таблица ⇒ Вставить 

таблицу) и введите число строк и столбцов таблицы. 

2. Для ввода информации в таблицу установите текстовый 

курсор в первую ячейку. Чтобы перейти к следующей 

ячейке в строке, нажмите клавишу Tab. Чтобы перейти в ячейку 

ниже, нажмите клавишу ↓. 

3. Чтобы добавить столбец перетаскиванием, установите 

инструмент Type (Текст) над правым краем одного из 

столбцов таблицы – указатель превратится в двойную 

стрелку – и начните перетаскивание вправо. 

Удерживайте клавишу Alt/Option и переместите 

указатель на небольшое расстояние. Когда вы отпустите 
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кнопку мыши, появится новый столбец, имеющий ту же 

ширину, что и расстояние, на которое был перемещен 

указатель. 

4. Чтобы преобразовать таблицу в текст, выполните 

команду Table ⇒ Convert Table To Text (Таблица ⇒ 

Преобразовать таблицу в текст). Табуляторы позволяют 

разделять то, что ранее было столбцами, а символы 

конца абзаца дают возможность разделять строки. 

Можно также изменить эти параметры. Подобным 

образом текст с табуляторами преобразовывается в таблицу. 

Достаточно выделить данный текст и выбрать Table ⇒ 

Convert Text To Table (Таблица ⇒ Преобразовать текст 

в таблицу). 

5. Для создания повернутого текста инструментом Type 

(Текст) поместите текстовый курсор в ячейку. 

Выполните команду меню Window ⇒ Type & Tables ⇒ 

Table (Окно ⇒ Текст и таблицы ⇒ Таблица). В палитре 

Table (Таблица) щелкните по кнопке Rotate Text 270° 

(Поворот текста на 270°) , а затем введите текст, который 

хотите разместить в этой ячейке. 
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СОВЕТЫ 

 

Совет №1. Вставка объекта внутрь фрейма 

 

Используйте команду «Вставить в», чтобы вложить 

изображения во фреймы контейнеров (рис. 1). Изображения 

можно вложить даже во вложенные фреймы. 

Рис. 1. Фоновое изображение, вставленное во фрейм 

 

Выполните одно из следующих действий: 

Чтобы вставить внутрь фрейма один объект, выделите 

его. 

Чтобы вставить внутрь фрейма два или более объектов, 

сначала сгруппируйте их, поскольку фрейм может содержать 

только один объект. 

Чтобы вставить текстовый фрейм внутрь другого фрейма 

и сохранить его текущий внешний вид, выделите весь 

текстовый фрейм с помощью инструмента «Выделение»  или 

«Частичное выделение» , но не инструмента «Текст». 

Выберите меню «Редактирование» > «Скопировать» (или 

«Редактирование» > «Вырезать», если не требуется сохранение 

оригинала). 

Выделите контур или фрейм, а затем выберите меню 

«Редактирование» > «Вставить в». 
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Совет №2. Удаление содержимого фрейма 

 

Выполните одно из следующих действий. 

При удалении графики или текстового фрейма выберите 

объект с помощью инструмента «Частичное выделение» . Или 

щелкните инструментом «Выделение» маркер захвата 

содержимого изображения. 

При удалении символов текста выделите их с помощью 

инструмента «Текст» . 

Выполните одно из следующих действий: 

Чтобы полностью удалить содержимое, нажмите 

клавишу Delete или Backspace. 

Чтобы поместить содержимое на поверхность макета, 

выберите меню «Редактирование» > «Вырезать», а затем 

отмените выделение фрейма и выберите меню 

«Редактирование» > «Вставить». 

Примечание. Импортированное изображение не может 

существовать без фрейма. Если вырезать из фрейма 

импортированное изображение и вставить его в любом месте 

документа, то для него будет автоматически создан новый 

фрейм. 

 

Совет №3. Подгонка объектов под размеры фрейма  

 

Если размеры фрейма и его содержимого не совпадают, 

можно воспользоваться командами «Подгонка», чтобы 

выполнить подгонку. 

Параметры выравнивания фрейма применимы к  фреймам, 

которые содержат графику или другой текстовый фрейм 

(текстовые фреймы, вложенные в другой фрейм), но они не 

влияют на абзацы внутри текстового фрейма. Для выравнивания 

и размещения самого текста используется команда «Параметры 

текстового фрейма», а также палитры «Абзац», «Стили абзацев» 

и «Материал». 
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 Подгонка размера объекта к размерам фрейма 

Выделите фрейм объекта. 

Выберите «Объект» > «Подгонка» и укажите один из 

следующих параметров: 

Содержимое по размеру фрейма 

Изменяет размеры содержимого по размеру фрейма 

и позволяет изменять пропорции содержимого. При этом, если 

содержимое и фрейм имеют разные пропорции, фрейм не 

изменится, а содержимое может быть растянуто. 

Фрейм по размеру содержимого 

Подгоняет фрейм к размеру содержимого (рис. 2). При 

необходимости пропорции фрейма изменятся в соответствии 

с пропорциями содержимого. Данная функция полезна для 

восстановления графического фрейма, который был случайно 

изменен. 

Примечание. Для быстрой подгонки фрейма к размеру 

его содержимого дважды щелкните любую угловую рукоять 

фрейма. Размер фрейма изменяется со всех сторон, независимо 

от того, в какой точке был выполнен щелчок. 

Если щелкнуть боковую рукоять, размер фрейма 

изменится только с данной стороны. 

Рис. 2. Выравнивание объекта внутри графического 

фрейма: 

А – Исходное 

Б – Размер фрейма подогнан к размеру содержимого 

В – Размер содержимого подогнан к размеру фрейма 
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Содержимое по центру фрейма 

Выравнивает содержимое по центру фрейма. Пропорции 

фрейма и содержимого сохраняются. Размеры содержимого 

и фрейма не изменяются. 

Уместить содержимое с сохранением пропорций 

Подгоняет размеры содержимого к размерам фрейма 

с сохранением пропорций содержимого. Размеры фрейма не 

изменяются. Если пропорции фрейма и содержимого не 

совпадают, могут появиться пустые пространства. 

Заполнить фрейм с сохранением пропорций 

Подгоняет размер содержимого для заполнения всего 

фрейма, сохраняя пропорции содержимого. Размеры фрейма не 

изменяются. Если содержимое и фрейм имеют разные 

пропорции, часть содержимого будет обрезана ограничительной 

рамкой фрейма. 

Примечание. Команды «Подгонка» подгоняют внешние 

края содержимого к центру обводки фрейма. Если у фрейма 

большая толщина обводки, то внешние границы содержимого 

будут скрыты. Можно задать выравнивание обводки фрейма 

по центру, по внутренней или внешней границе фрейма.  

Чтобы удалить нежелательные результаты применения 

функции автоподгонки, выберите меню «Объект» > 

«Подгонка» > «Сбросить параметры подгонки фрейма». 

 Использование автоподгонки 

Если параметр «Автоподгонка» не установлен, при 

изменении размера фрейма изображения размер самого 

изображения не изменяется. При установленном параметре 

«Автоподгонка» размер изображения изменяется вместе с размером 

фрейма. Если необходимо обрезать или трансформировать само 

изображение при установленном параметре «Автоподгонка», 

используйте инструмент «Частичное выделение». Или 

отключите параметр «Автоподгонка», трансформируйте 

изображение и снова включите «Автоподгонку». 
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Параметр «Автоподгонка» можно установить на панели 

«Управление» и в диалоговом окне «Параметры подгонки 

фрейма». 

 Установка параметров подгонки фрейма 

Параметр подгонки можно связать с шаблонным 

фреймом, чтобы соответствующая команда подгонки 

применялась всякий раз, когда в этот фрейм помещается новое 

содержимое. 

Выделите кадр. 

Выберите меню «Объект» > «Подгонка» > «Параметры 

подгонки фрейма». 

Укажите описанные ниже параметры и нажмите кнопку 

«ОК». 

Автоматическая подгонка 

Выберите этот параметр, чтобы размер изображения 

автоматически изменялся при изменении размера фрейма. 

Контрольная точка 

Укажите контрольную точку для операций кадрирования 

и подгонки. Например, если контрольную точку установить 

в верхнем правом углу и выбрать параметр «Уместить 

содержимое с сохранением пропорций», изображение может 

обрезаться либо слева, либо снизу (с противоположной стороны 

от контрольной точки). 

Обрезка 

Укажите местоположение ограничительной рамки 

изображения относительно фрейма. Для обрезки изображения 

используйте положительные значения. Например, можно 

исключить границы вокруг изображения. Для добавления 

интервала между ограничительной рамкой изображения и фреймом 

укажите отрицательные значения. Например, может 

понадобиться оставить пробелы между изображением и фреймом. 

Если ввести значения обрезки, которые делают 

изображение невидимым, эти значения игнорируются, в то 

время как параметр подгонки по-прежнему применяется. 
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Подгонка к пустому фрейму 

Укажите способ подгонки: подгонка содержимого к фрейму 

(возможно усечение изображения), пропорциональная подгонка 

содержимого (возможно появление пустого пространства) или 

пропорциональное заполнение фрейма (одна или несколько 

сторон могут обрезаться). 

Операция подгонки выполняется только в том случае, 

если содержимое помещается во фрейм. При изменении размера 

фрейма повторное применение параметра подгонки происходит 

автоматически только в том случае, если выбран параметр 

«Автоподгонка». 

 

Совет №4. Перемещение графического фрейма или 

его содержимого 

 

При использовании инструмента «Выделение» для 

выбора графического фрейма, можно выбрать фрейм целиком 

или изображение внутри фрейма. При нажатии за пределами 

маркера захвата содержимого и перетаскивании  выделения 

содержимое фрейма перемещается вместе с фреймом. При 

перетаскивании маркера захвата содержимого изображение 

перемещается внутри фрейма (рис. 3). 

Рис. 3. Перемещение содержимого, но не фрейма 

 

Далее описаны варианты перемещения фрейма или его 

содержимого независимо друг от друга. Они могут оказаться 
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полезными при настройке кадрирования и маскирования 

изображения внутри фрейма. 

 

Примечание. Если инструмент выделения работает не 

так, как ожидается, попробуйте сначала отменить выделение 

всех объектов. Это можно сделать, нажав клавиши 

«Ctrl»+«Shift»+«A» (Windows) или «Command»+«Shift»+«A» 

(Mac OS). 

 

Выполните одно из следующих действий: 

 Чтобы переместить фрейм вместе с его содержимым, 

щелкните изображение за пределами маркера захвата 

содержимого инструментом «Выделение» . 

 Чтобы переместить импортированное содержимое, не 

перемещая фрейм (то есть,сместить содержимое за 

пределы фрейма), перетащите маркер захвата 

содержимого. Можно также использовать инструмент 

«Частичное выделение»  для выбора и перетаскивания 

изображения. 

Примечание. Если держать нажатой кнопку мыши на 

изображении до перемещения, то появится динамическое 

представление внешнего вида фрейма (полупрозрачное 

изображение на заднем плане), однако представление 

перемещаемого внутри фрейма изображения будет обычным. 

Это позволяет увидеть, каким образом все изображение 

будет располагаться внутри фрейма. 

 Чтобы переместить фрейм, не перемещая его 

содержимого, выберите инструмент «Выделение», 

щелкните фрейм, перейдите к инструменту «Частичное 

выделение», затем перетащите его центральную точку 

(рис. 4). 



 

105 

 

Рис. 4. Перемещение фрейма, но не его содержимого 

 

 Чтобы переместить несколько фреймов, при помощи 

инструмента «Выделение» выделите объекты, а затем 

перетащите их. Если инструмент «Частичное выделение» 

применяется для выделения нескольких объектов, то 

затрагивается только перетаскиваемый элемент. 

 

Совет №5. Создание границы или фона 

 

Графический фрейм идеально подходит для 

использования в качестве границы или фона для своего 

содержимого, поскольку позволяет менять обводку и заливку 

независимо от своего содержимого (рис. 5). 
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Рис. 5. Добавление границ к графическим фреймам 

А – Фотография в графическом фрейме 

Б – Фрейм с примененной обводкой 

В – Увеличенный фрейм с обводкой и заливкой 

 

 Чтобы выбрать фрейм целиком, щелкните 

импортированный графический объект за пределами 

маркера захвата содержимого инструментом 

«Выделение» . 

 Чтобы увеличить фрейм, не изменяя размер 

изображения, перетащите за пределы фрейма любой из 

маркеров ограничительной рамки. Чтобы сохранить 

пропорции фрейма, во время перетаскивания 

удерживайте нажатой клавишу «Shift». 

 Цвета обводки и заливки могут быть заданы на палитре 

«Образцы» или панели «Инструменты». 

 Палитра «Обводка» позволяет настроить толщину, стиль 

и выравнивание обводки фрейма. 

Примечание. Быстро увеличить фрейм равномерно со 

всех сторон можно с помощью панели «Управление» или 

палитры «Трансформирование». Выделите фрейм с помощью 

инструмента «Частичное выделение» , установите локатор 

контрольной точки  к центральной точке и введите новые 

значения для ширины и высоты. 
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Совет №6. Кадрирование и маскирование объектов  

 

Оба термина – кадрирование и маскирование – обозначают 

скрытие части объекта. В целом различие между ними состоит в 

том, что при кадрировании используется прямоугольник для 

обрезки краев изображения, а при маскировании используется 

произвольная форма, чтобы сделать фон объекта прозрачным. 

Распространенным примером маски является обтравочный 

контур, который представляет собой маску, созданную для 

конкретного изображения. 

Для кадрирования или маскирования объектов используйте 

графические фреймы. Поскольку импортированная графика 

всегда содержится во фрейме, ее можно сразу же кадрировать 

или маскировать без необходимости создания фрейма. Если 

фрейм для импортированной графики не был создан вручную, 

для нее автоматически будет создан фрейм аналогичного 

размера, по этой причине наличие фрейма не всегда очевидно. 

Примечание. В целях оптимизации печати печатаются 

только данные видимых частей кадрированных или 

маскированных изображений документа. Кроме того, можно 

сохранить дисковое пространство и оперативную память, если 

сначала обрезать или замаскировать изображения до 

желаемых форм и размеров, а уже после импортировать 

в документ. 

 Чтобы обрезать импортированное изображение или 

любой другой графический объект, помещенный в 

прямоугольный фрейм, щелкните объект с помощью 

инструмента «Выделение»  и перетащите любую 

рукоять на появившейся ограничительной рамке. Чтобы 

сохранить исходные пропорции фрейма, удерживайте 

нажатой клавишу «Shift» при перетаскивании (рис. 6). 
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Рис. 6. Кадрирование изображения с помощью графического 

фрейма 

 

 Чтобы обрезать или замаскировать любой объект, 

выделите один объект для маскирования с помощью 

инструмента «Выделение» или «Частичное выделение» 

. Выберите меню «Редактирование» > «Скопировать», 

выделите пустой контур или фрейм меньшего размера, чем 

объект, а затем выберите «Редактирование» > «Вставить в». 

 Чтобы выполнить точную обрезку содержимого фрейма, 

выделите фрейм инструментом «Частичное выделение» и с 

помощью панели «Управление» или «Трансформирование» 

измените его размер. 

 Чтобы указать настройки обрезки для пустого 

шаблонного фрейма, выберите меню «Объект» > 

«Подгонка» > «Параметры подгонки фрейма», а затем 

задайте величину обрезки. 

Примечание. Для импортированной графики можно 

также создать маску, используя инструменты рисования для 

изменения формы существующего фрейма графического 

объекта. 
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Совет №7. Создание красивых фигур 

 

А сейчас самое красивое в этой теме – применяя этот 

эффект к звезде, нарисованной при помощи инструмента 

Poligon Frame Tool, можно получать такие красивые фигуры 

(рис. 7). 

 

 
 

Рис. 7. Эффекты, которые можно получить при помощи 

инструмента Poligon Frame Tool 

 

 

Здесь задействован Gap color и ко второй фигуре 

применен скрипт Corner Effects. 
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Совет №8. Трансформирование объектов 

 

Группа команд Transform Again – одна из самых мощных 

в Adobe InDesign. Она доступна в меню Object в четырех 

вариантах (рис. 8): 

Рис. 8. Группа команд Transform Again 

 

Действие этих команд неочевидно и мы попытаемся 

разобраться, как же действует каждая из них. Во-первых, надо 

четко представлять, что означает Transform в Adobe InDesign. 

Команды класса Transform выполняют следующие действия: 

изменение положения, вращение, масштабирование, зеркальное 

отражение и наклон (shear) объектов. Также в этот класс входят 

команды подгонки размеров объекта к размеру фрейма 

(содержимое по размеру фрейма, фрейм по размеру 

содержимого и др.). 

 

 Transform Again 

Это самая простая из всех команд. Она повторяет 

последнюю операцию трансформирования, которую вы 

применили к объекту. На рисунке 9 крайнее левое фото 

сдублировано перетаскиванием при нажатой клавише 

Option/Alt. 
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Рис. 9. Дублирование крайнего левого фото 

 

В то время, пока еще выделение с дубликата фото не 

снято, выберем из меню команду Object > Transform Again 

и выделенное фото скопируется еще раз, переместившись от 

своего оригинала на такое же расстояние, как и первая копия 

(рис. 10). 

Рис. 10. Повторное копирование фото при помощи 

команды Transform Again 

 

Команду Transform Again можно применять не только 

к первичному объекту и его копиям, но также и к другим 

объектам. 

На рисунке ниже было выделено сразу три объекта (3, 4 

и 5-е фото) и два раза была вызвана команда Transform Again 

(рис. 11).  
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Рис. 11. Дважды примененная к трем фото команда Transform 

Again 

 

 Transform Sequence Again 

Если предыдущая команда повторяла одно последнее 

действие трансформирования, то эта команда может повторить 

серию таких действий. На рисунке 12 крайнее левое фото было 

перемещено, уменьшено и повернуто. 

Рис. 12. Перемещение, уменьшение, поворот левого фото 

 

Выделим 2-е фото и выполним команду Object > 

Transform Again > Transform Sequence Again. Та же самая 

последовательность трансформаций будет к нему применена 

(перемещение, уменьшение, поворот) (рис. 13). 
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Рис. 13. Применение последовательности трансформаций 

первого изображения ко второму при помощи команды 

Transform Sequence Again 

 

Здесь важно понять, что повторяться будет именно 

последняя серия трансформаций. Если мы увеличим объект, 

потом перекрасим его в другой цвет, потом повернем и переместим, 

то командой Transform Sequence Again будут выполняться 

только поворот и перемещение, но не увеличение. Увеличение 

объекта не вошло в последнюю серию действий 

трансформирования, так как после него было выполнено 

изменение цвета – операция не относящаяся 

трансформированию. Как мне показалось, операция изменения 

цвета стала точкой отсчета для записи в стэк новой 

последовательной серии команд трансформирования. 

Допустим, над прямоугольником были выполнены 

следующие действия: увеличение размеров, поворот, заливка 

цветом, увеличение толщины контура. Выполнит ли команда 

Transform Sequence Again какие-либо действия в этом случае, 

ведь последними действиями были операции, не входящие 

в группу Transform? Предлагаем вам поэкспериментировать, 

применяя по несколько раз эту команду к первоначальному 

объекту и к другим объектам, и тем самым самим найти ответ 

на этот вопрос. 
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 Transform Again Individually 

Эта команда используется для повторения последней 

операции трансформирования к нескольким выделенным 

объектам, применяя вышеуказанное действие индивидуально 

к каждому объекту. На рисунке 14 крайнее левое фото было 

повернуто. 

Рис. 14. Поворот крайнего левого изображения 

 

Выделим оставшиеся 5 фото и применим к ним первую 

рассмотренную нами команду Transform Again (рис. 15). 

Рис. 15. Поворот пяти выделенных изображений с помощью 

команды Transform Again 

 

Все фото повернулись, как будто это один объект. 

Если же теперь отменить предыдущее действие и применить 

к выделенным фото команду Transform Again Individually то 

получим поворот каждой отдельной картинки (рис. 16): 

Рис. 16. Поворот пяти выделенных изображений с помощью 

команды Transform Again Individually 
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 Transform Sequence Again Individually 

Эта команда похожа на предыдущую: она так же 

применяется для нескольких выделенных объектов,  

но в  отличие от неѐ выполняет не одно действие, а несколько 

последних операций трансформирования. На рисунке 17 

крайнее левое фото было повернуто, уменьшено и перемещено. 

Рис. 17. Перемещение, уменьшение, поворот левого 

изображения 

 

Выделим оставшиеся пять изображений и применим 

команду Object > Transform Sequence Again Individually , 

и каждая отдельная картинка будет повернута, 

уменьшена и перемещена (рис. 18). 

Рис. 18. Перемещение, уменьшение, поворот оставшихся 

пяти изображений при помощи команды 

Transform Sequence Again Individually 

 

Знание и применение на практике этих команд поможет 

вам сэкономить время во время работы. 

 

Совет №9. Создание тени 

 

Сделав тень в Adobe Photoshop к изображению для 

фотомонтажа и поместив потом эту картинку в Adobe InDesign, 

вы заметите, что тень выглядит не совсем так, как бы этого 

хотелось. Она может иметь посторонний цветовой оттенок 
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и в некоторых случаях, она даже светлее фона. Рассмотрим 

подробнее эту проблему. 

Тень создана к обтравленному изображению (CMYK) как 

стиль слоя (рис. 19). 

Рис. 19. Тень к обтравленному изображению в Adobe Photoshop 

 

Сохранив этот файл как *.psd и поместив его в Adobe 

InDesign, мы увидим неприглядную картину с тенью (рис. 20) 

Рис. 20. Файл *.psd, открытый в Adobe InDesign 
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Вероятно, причина этого в том, что в Photoshop режим 

наложения для тени при еѐ создании по умолчанию установлен 

в Multiply, а в Adobe InDesign режим наложения Normal 

применен для всего изображения. Можно сказать, что установка 

Adobe Photoshop Multiply теряется. 

Разделим в Adobe Photoshop изображение цветка и его 

тень. Для этого установим курсор на слой с тенью и нажмем 

правую кнопку мыши (рис. 21). 

Рис. 21. Создание отдельного слоя для тени цветка 
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Выберем Create Layer (рис. 22). 

Рис. 22. Отдельный слой для тени цветка 

 

Теперь рисунок состоит из двух слоев – цветка и тени 

к нему. Сохраним изображение и обновим его в Adobe InDesign. 

Далее в Adobe InDesign для тени сделаем режим 

наложения Multiply, а для цветка – Normal. Для этого 

потребуется две копии изображения, в которых мы будем 

отключать ненужные слои из Adobe Photoshop. В Adobe InDesign 

зайдем в меню Object > Object Layer Option и отключим слой с цветком 

(рис. 23). 

Рис. 23. Отключение слоя с цветком 

 

Видимой останется тень. Зададим ей режим наложения 

Multiply (рис. 24). 
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Рис. 24. Применение для тени режима наложения Multiplay 

 

Скопируем тень в буфер обмена и командой 

Shift+Ctrl+Alt+V вставим на то же место, получив копию 

изображения. Для вставленного из памяти изображения в опциях 

слоев сделаем невидимым слой с тенью и видимым слой с цветком 

(рис. 25). 

Рис. 25. Невидимый слой с тенью и видимый – с цветком 
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Для скопированного из буфера обмена изображения 

также установлен режим Multiply и необходимо его поменять 

на Normal. После этого мы видим нормальную тень (рис. 26). 

Рис. 26. Конечный результат 

 

Очевидно, этой методикой и надо пользоваться, если 

возникнет необходимость использовать в Adobe InDesign тень 

из Adobe Photoshop. 

 

Совет №10. Текст вдоль фрейма 

 

Предположим, что есть рисунок с наложенным на него 

текстовым блоком (рис. 27). 
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Рис. 27. Рисунок с наложенным на него текстовым блоком 

 

Нужно изменить край текстового фрейма так, чтобы 

рисунок был виден целиком. 

Выделите текстовый фрейм Черной стрелкой и выберите 

инструмент Карандаш. Проведите кривую линию вдоль контура 

рисунка – перо должно начать и закончить движение на краю 

фрейма (рис. 28). 

Рис. 28. Кривая линия вдоль контура рисунка 
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После отпускания кнопки эта линия станет частью 

контура текстового фрейма и рисунок будет открыт (рис. 29). 

Рис. 29. Текст вдоль контура рисунка 

 

Как известно, произвольные отступы для текста в  текстовом 

фрейме можно задать только в том случае, когда фрейм имеет 

строго прямоугольную форму. Стоит только закруглить углы, и 

мы уже не можем ввести разные отступы слева и справа, сверху 

и снизу (рис. 30). 

Рис. 30. В фрейме с закругленными углами невозможно задать 

произвольные отступы 
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Совет №11. Текст внутри круга 

 

Расположите текст в обычном прямоугольном текстовом 

фрейме. 

Нарисуйте круг с таким же диаметром, как и ширина 

текстового фрейма 

Задайте обтекание для круга – на панели Text Wrap 

нажмите кнопку Wrap around object shape и поставьте галочку 

Invert. 

На этой же панели задайте нужный вам отступ для 

обтекания (рис. 31). 

Рис. 31. Текст внутри круга 

 

Совместите текстовый фрейм и круг с обтеканием так, 

чтобы их центры совпадали (для этого можно воспользоваться 

панелью Align) и получите текст в центре круга 

Представьте, что при работе в Adobe InDesign возникла 

необходимость написать текст на поверхности цилиндра, 

конуса, грани пирамиды. Наверняка инструменты программы 

Illustrator помогут справиться с этой задачей, но хотелось бы еѐ 

решить, не покидая программы верстки. 
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Adobe InDesign предлагает несколько эффектов для 

текста по контуру (рис. 32). 

Рис. 32. Варианты размещения текста вдоль контура 

 

Rainbow (радуга) – линия шрифта каждой буквы 

совпадает с касательной к контуру 

Skew (скос) – буквы искажаются таким образом, что 

горизонтальные штрихи следуют форме контура, а  вертикальные 

штрихи параллельны боковому краю полосы. 

3D Ribbon (трехмерная лента) – наклон вертикальных 

штрихов зависит от формы контура, а горизонтальные 

параллельны нижней линии полосы. 

Stair Step (ступеньки) – линия шрифта касается контура, 

при этом буквы не поворачиваются. 
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Gravity (гравитация) – ось каждой буквы направлена 

в центр фрейма. Близость буквы к этому центру и совпадение 

вертикальных элементов буквы с направлением на центр 

обусловливают сильное искажение букв. 

Очевидно, что skew хорошо подходит для написания 

текста вдоль поверхности цилиндра, что и продемонстрировано 

на рис. 33. 

Рис. 33. Применение эффекта skew – текст на цилиндре 

 

А как быть с конусом и пирамидой? На первый взгляд, 

среди имеющихся эффектов ни один не подходит. 

Но это не так, взгляните на последнюю строку рисунка 1, 

в которой текст искажен эффектом gravity. Именно этот 

инструмент позволит решить нашу задачу. 

Метод 

Суть эффекта gravity состоит в том, что буквы 

размещенного по контуру текста притягиваются к центру 

фрейма, содержащего этот контур. Если задаться целью 

модифицировать содержащий контур фрейм так, чтобы его 

центр совпадал с вершиной пирамиды, можно ожидать, что 

текст вдоль еѐ основания «ляжет» на ее грани. 
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Видоизменить фрейм можно добавлением к текущему 

контуру с текстом прямой линии – изменяя ее длину и угол, 

можно перемещать на экране центр фрейма. 

 

Решение 

 

Добавим новый слой в документе для работы с текстом. 

Сделаем контур вдоль видимой части основания конуса 

или пирамиды. 

Напишем текст, отформатируем по длине контура. 

Добавляется новая линия к имеющемуся текстовому контуру 

так: 

Делаем активным инструмент Перо. Пока ничего не 

выбрано, рядом с пером крестик. 

Подведя перо к краю контура (при этом крестик 

сменится на наклонную линию) дважды щелкнем на этой точке. 

Теперь щелкнем мышкой в стороне от контура. 

В результате наш контур стал длиннее на один прямой 

сегмент. Важно, что с появлением этого сегмента 

форматирование текста осталось прежним, но изменилось 

положение центра фрейма с текстовым контуром и, изменяя 

длину и направление сегмента, можно перемещать этот центр. 

Выберите этот контур белой стрелкой, возьмите 

свободный конец нового сегмента и посмотрите, как с  изменением 

его длины и направления перемещается центр фрейма и 

меняется вид текста. 

На рис. 34 видно, что при совмещении центра фрейма 

с вершиной конуса получился эффект написания букв по 

поверхности конуса. 
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Рис. 34. Совмещение центра фрейма с вершиной конуса 

 

На рис. 35 приведен пример размещения текста на гранях 

усеченной пирамиды. 

В процессе построения были нарисованы грани для 

нахождения вершины пирамиды. После совмещения центра 

фрейма с вершиной пирамиды все вспомогательные линии 

удалены, и контур сделан невидимым. 

Рис. 35. Буквы лежат на гранях пирамиды 
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Совет №12. Текст вдоль кривой линии 

 

Используем возможности Adobe InDesign для создания 

текста, располагающегося вдоль кривой линии, с переходом его 

на другие кривые. 

Ниже на рисунке 36 представлен окончательный 

результат, который мы хотим получить. 

Рис. 36. Конечный результат 

 

Шаг 1. Рисование кривой линии 

С помощи Pen Tool (P) или Pencil Tool (N) нарисуйте 

волнистую линию. В панели Stroke или в Панели управления 

(Control panel) задайте толщину линии в 1 pt. Мы удалим линию 

позже, но пока она нужна нам видимой. (рис. 37). 
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Рис. 37. Рисование кривой линии 

 

Шаг 2. Подготовка кривой для текста по контуру 

Выберите инструмент Path Type Tool (Текст по контуру) 

или нажмите для этого Shift + T и затем щелкните на кривой, 

которая была нарисована на шаге 1. Это превратит кривую 

в контур для текста (рис. 38). 

Рис. 38. Подготовка кривой для текста по контуру 

 

Шаг 3. Дублирование кривой 

Выделите кривую инстументом Selection (черная 

стрелка), нажмите клавишу Alt и утащите кривую на некоторое 

расстояние вниз, немного сместив еѐ вправо (рис. 39). 
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Рис. 39. Дублирование кривой 

 

Шаг 4. Еще три раза дублируем кривую 

Выберите команду из меню Object > Transform Again > 

Transform Again или нажмите Command/Ctrl + Alt + 3, затем 

повторите это действие ещѐ два раза. Таким образом, у нас 

получилось пять кривых (рис. 40). 

Рис. 40. Дублирование кривой еще три раза 

 

Шаг 5. Текст по контуру для верхней кривой 

Щелкните над верхней кривой инструментом Text. Вы 

увидите мигающий курсор с левой стороны кривой. Выполните 

команду File > Place, чтобы пустить текст по контуру из файла 

на диске, или Edit > Paste, если текст находится в буфере 

обмена (рис. 41). 
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Рис. 41. Текст по контуру для верхней кривой 

 

Шаг 6. Продолжим текст на других кривых 

Инструментом Selection выделим верхнюю кривую. 

В правом ее конце увидим красный знак переполнения текста. 

Щелкнем по нему, взяв избыточный текст «на курсор» 

и затем щелкнем по нижерасположенной кривой, пуская по ней 

неразмещенный текст. Повторим эту процедуру для оставшихся 

кривых, щелкая по значку переполнения и затем по 

нижележащей кривой (рис. 42, 43). 

Рис. 42. Знак переполнения текста 
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Рис. 43. Продолжение текста на других кривых 

 

Шаг 7. Деформация текста 

Для того, чтобы будущий флаг был более реалистичен, 

требуется немного исказить текст. Инструментом Selection 

выделим все пять кривых. Выберем из меню Type > Type on 

a Path > Options. В появившемся диалоговом окне установим 

эффект Skew, и нажмем кнопку OK (рис. 44). 

Рис. 44. Деформация текста 
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Шаг 8. Форматирование текста Инструментом Text 

выделите весь текст и при помощи панелей Character, 

Paragraph или Control panel установите параметры текста 

такими, какими вы хотите его видеть. В этом примере применен 

параметр full justification ко всему тексту для полного 

заполнения всех кривых текстом, включая последнюю кривую 

(рис. 45). 

Рис. 45. Форматирование текста 

 

Шаг 9. Делаем кривые линии невидимыми. Снова 

выделяем наши пять кривых и в панели Swatches задаем для 

них параметр None (рис. 46). 
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Рис. 46. Невидимые кривые линии 

 

Шаг 10. Создание двух цветов 

Чтобы сделать флаг более реалистичным мы применим 

градиент к тексту, состоящий из двух оттенков – светлого и темного. 

Для этого сначала 

создадим образцы 

эти цветов – Flag red 

и Dark flag red (рис. 

47).   

 

 

 

 

 

 

 

 

 

 

Рис. 47. Создание двух 

цветов 
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Шаг 11. Создание градиента 

Из меню панели Swatches выберем команду New Gradient 

Swatch и создадим градиент от красного к темно-красному. Для 

этого в диалоговом окне щелкнем по левому прямоугольнику 

цветовой шкалы градиента Gradient Ramp (этот прямоугольник 

называется контрольной точкой градиента) и зададим для него 

цвет Flag Red, созданный на предыдущем шаге (рис. 48). 

Рис. 48. Создание градиента 

 

Затем щелкнем под цветовой полоской шкалы градиента 

для создания следующей контрольной точки градиента 

и зададим ей цвет Dark flag red (рис. 49). 

Рис. 49. Создание следующей контрольной точки 
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Продолжаем создавать контрольные точки, пока их не 

окажется всего пять с чередующимися цветами Flag red – Dark 

flag red – Flag red – Dark flag red – Flag red (рис. 50). 

Рис. 50. Создание контрольных точек 

 

Шаг 12. Применим градиент к тексту 

Выделим весь наш текст инструментом Text и в панели 

Swatches нажмем на созданный градиент. Снимем выделение 

с текста (рис. 51). 

 

 

 

Рис. 51. 

Применение 

градиента  

к тексту 

 

Совет 

№13. 



 

137 

 

Трансформирование текста 

 

Кроме трансформирования фреймов с сохранением 

шрифтовых параметров текста и параметров абзаца, имеется 

возможность вместе с фреймом трансформировать и  находящийся 

в нем текст. Для этого предназначена палитра работа с 

текстовыми фреймами Transform (Трансформирование), а 

также инструменты палитры Tools (Инструменты), Rotate 

(Поворот) Reflect (Отражение) Scale (Масштабирование) Shear 

(Наклон (скос) и Free Transform (Свободное 

трансформирование) Пример трансформирования текста 

приводится на рис. 52. 

Приемы использования инструментов масштабирования 

ничем не отличаются от использования аналогичных 

инструментов в программах векторной графики, например, 

в программе Adobe Illustrator. 

Рис. 52. Примеры трансформирования текста: А – 

исходный текст; Б – масштабирование; В – поворот; Г – наклон 
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Пример текста, преобразованного в кривые, приводится 

на рис. 53, справа. 

Рис. 53. Слева исходный текст, справа – 

преобразованный в кривые 
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ЗАДАНИЯ ДЛЯ САМОСТОЯТЕЛЬНОГО ВЫПОЛНЕНИЯ 

 

Упражнение 1. Создание буклета с использованием 

созданной таблицы 

 

Создайте буклет, используя таблицы (рис. 1): 

Рис. 1. Буклет 
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Упражнение 2. Создание буклета с использованием 

встроенной таблицы 

 

Создайте буклет, используя таблицы (рис. 2): 

Рис. 2. Буклет 
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Упражнение 3. Создание буклета с использованием 

текста вдоль контура  

 

Создайте буклет, используя текст вдоль и внутри круга 

(рис. 3): 

Рис. 3. Буклет 
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Упражнение 4. Создание буклета с использованием 

текстовых эффектов  

 

Создайте буклет, используя текстовые эффекты (рис. 4): 

Рис. 4. Буклет 
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Упражнение 5. Создание таблицы 

 

Создайте таблицу (рис. 5.): 

Рис. 5. Таблица 
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Упражнение 6. Создание буклета с использованием 

таблицы с заливкой ячеек  

 

Создайте буклет, используя таблицы (рис. 6): 

 

Рис. 6. Буклет 
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Упражнение 7. Создание буклетов 

 

Создайте буклеты, используя различную графику и 

спецэффекты (рис. 7,8,9,10,11,12,13,14,15,16): 

 

  

Рис. 7. Буклет 
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Рис. 8. Буклет 
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Рис. 9. Буклет 

 



 

148 

 

Рис. 10. Буклет 

Рис. 11. Буклет 



 

149 

 

 

Рис. 12. Буклет 
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Рис. 13. Буклет «Календарь» 
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Рис. 14. Буклет 
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Рис. 15. Буклет 
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Рис. 16. Буклет 
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ПРИЛОЖЕНИЕ 1 

 

Клавиатурные сокращения команд и инструментов 

 

Меню Edit 

Clear (Удалить) Backspace/Delete  

Сору (Копировать)  Ctrl+C 

Cut (Вырезать)  Ctrl+X 

Deselect All (Снять выделение) Ctrl+Shift+A 

Сору (Копировать)  Ctrl+Alt+Shift+D 

Find Next (Следующий)  Ctrl+Alt+F 

Find/Change (Найти/Заменить)  Ctrl+F 

Paste (Вклеить) Ctrl+V 

Paste in Place (Вклеить на место) Ctrl+Alt+Shift+V 

Paste Into (Вклеить в)  Ctrl+Alt+V 

Preferences: General (Установки: Основные)  Ctrl+K 

Redo (Повторить) Ctrl+Shift+Z 

Select All (Выделить всѐ)  Ctrl+A 

Step and Repeat (Вклеить многократно)  Ctrl+Shitt+V 

Undo (Отменить)  Ctrl+Z 

Меню File 

Close (Закрыть)  Ctrl+W, Ctrl+F4 

Document Setup (Параметры документа)  Ctrl+Alt+P 

Exit (Выход)  Ctrl+Q 

Export (Экспортировать)  Ctrl+E 

New: Document (Новый: Документ)  Ctrl+N 
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Open (Открыть)  Ctrl+O 

Package (Сформировать пакет)  Ctrl+Alt+Shift+P 

Place (Поместить) Ctrl+D 

Preflight (Проверить) Ctrl+Alt+Shift+F 

Print (Печатать)  Ctrl+P 

Save (Сохранить)  Ctrl+S 

Save a Copy (Сохранить копию)  Ctrl+Alt+S 

Save As (Сохранить как)  Ctrl+Shift+S 

Меню Layout 

First Page (Первая страница)  Ctrl+Shift+PageUp 

Go Back (Пролистать назад)  Ctrl+PageUp 

Go Forward (Пролистать вперед)  Ctrl+PageDown 

Last Page (Последняя страница) Ctrl+Shift+PageDown 

Next Page (Следующая страница)  Shift+PageDown 

Previous Page (Предыдущая страница)  Shift+PageUp 

Меню Object 

Bring Forward (Сдвинуть вперед) Ctrl+] 

Bring to Front (На передний план)  Ctrl+Shift+] 

Send Backward (Сдвинуть назад)  Ctrl+[ 

Send to Back (На задний план) Ctrl+Shift+[ 

Clipping Path (Обтравочный контур)  Ctrl+Alt+Shift+K 

Compound: Make (Составные контуры: 

Создать)  
Ctrl+8 

Compound: Release (Составные контуры: 

Разблокировать)  

Ctrl+Alt+8 

Corner Effects (Угловые эффекты) Ctrl+Alt+R 
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Drop Shadow (Задать тень) Ctrl+Alt+M 

Center Content (Центрировать содержимое)  Ctrl+Shift+E 

Fit Content Proportionally (Сохранить 

пропорции содержимого)  

Ctrl+Alt+Shift+E 

Fit Content to Frame (Содержимое по 

размеру фрейма)  

Ctrl+Alt+E 

Fit Frame to Content (Настроить размер 

фрейма по содержимому)  

Ctrl+Alt+C 

Group (Сгруппировать) Ctrl+G 

Lock Position (Блокировать) Ctrl+L 

Text Frame Options (Параметры 

текстового фрейма)  
Ctrl+B 

Ungroup (Разгруппировать)  Ctrl+Shift+G 

Unlock Position (Отменить блокировку)  Ctrl+Alt+L 

Меню палитр 

Redefine Style (Переопределить стиль)  Ctrl+Alt+Shift+C/R 

All Caps (Все прописные)  Ctrl+Shift+K 

Small Caps (Капители)  Ctrl+Shift+H 

Strikethrough (Перечеркивание)  Ctrl+Shift+/ 

Subscript (Нижний индекс)  Ctrl+Alt+Shift+= 

Superscript (Верхний индекс)  Ctrt+Shift+= 

Underline (Подчеркивание) Ctrl+Shift+U 

Hyphenation (Перенос) Ctrl+Alt+H 

Justification (Интервалы)  Ctrl+Alt+Shift+J 

Keep Options (Удержать строки)  Ctrl+Alt+K 

Paragraph Rules (Линии абзаца)  Ctrl+Alt+J 
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Меню Tables 

Cell Options: Text (Параметры ячейки: Текст)  Ctrl+Alt+B 

Delete: Column (Удалить: Столбец)  Shift+Backspace 

Delete: Row (Удалить: Строку)  Ctrl+Backspace 

Insert Table (Добавить таблицу)  Ctrt+Alt+Shift+T 

Insert: Column (Вставить: Столбец)  Ctrl+Alt+9 

Insert: Row (Вставить: Строку)  Ctrl+9 

Select: Cell (Выбрать: Ячейку)  Ctrl+/ 

Select: Column (Выбрать: Столбец)  Ctrl+Alt+3 

Select: Row (Выбрать: Строку)  Ctrl+3 

Select: Table (Выбрать: Таблица)  Ctrl+Alt+A 

Table Setup (Настройка таблицы)  Ctrl+Alt+T 

Текст и таблицы 

Align center (Выключка по центру)  Ctrl+Shift+C 

Align force justify (Выключка полная)  Ctrl+Shin+F 

Align justify (Выключка по формату 

влево)  
Ctrl+Shift+J 

Align left (Выключка влево)  Ctrl+Shift+L 

Align right (Выключка вправо) Ctrl+Shift+R 

Align to baseline grid (Выровнять по сетке)  Ctrl+Alt+Shift+G 

Apply bold (Полужирное начертание)  Ctrl+Shift+B 

Apply italic (Курсивное начертание)  Ctrl+Shift+l 

Apply normal (Обычное начертание)  Ctrl+Shift+Y 

Auto leading (Автоинтерлиньяж)  Ctrl+Alt+Shift+A 

Auto-hyphenate on/off (Автоматический 

перенос включить/выключить)  

Ctri+Alt+Shift+H 
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Clear (Удалить)  Backspace 

Decrease baseline shift (Смещение 

базовой линии вниз) 

Alt+Shffl+Down 

Decrease baseline shiftxS (Смещение 

базовой линии вниз на 5 ед.)  

Ctrl+Alt+Shitt+Down 

Decrease kerning/tracking (Уменьшить 

кернинг/трекинг)  

Alt+Lett 

Decrease kerning/trackmgxS (Уменьшить 

кернинг/трекинг на 5 ед.)  

Ctrl+Alt+Left 

Decrease leading (Уменьшить интерлиньяж) Alt+Up 

Decrease leadingxS (Уменьшить 

интерлиньяж на 5 ед.)  

Ctrl+Alt+Up 

Decrease point size (Уменьшить размер 

кегля)  
Ctrl+Shift+, 

Decrease point sizexS (Уменьшить размер 

кегля на 5 ед.)  

Ctrl+Alt+Shift+, 

Decrease word space (Уменьшить 

интервал между словами)  

Ctrl+Alt+Backspace 

Decrease word spacexS (Уменьшить 

интервал между словами на 5 ед.)  

Ctrl+Alt+Shift+Backs

pace 

Delete (Удалить)  Delete 

Find Next (Следующий)  Shift+F2 

Increase baseline shift (Смещение базовой 

линии вверх) 

Alt+Shift+Up 

Increase baseline shiftxS (Смещение 

базовой линии вверх на 5 ед.)  

Ctrl+Alt+Shfft+Up 

Increase kerning/tracking (Увеличить 

кернинг/трекинг)  
Alt+Rlght 

 



 

160 

 

Increase kerning/trackingxS (Увеличить 

кернинг/трекинг на 5 ед.)  

Ctrl+Alt+Right 

Increase leading (Увеличить интерлиньяж)  Alt+Down 

Increase leadingxS (Увеличить 

интерлиньяж на 5 ед.) 
Ctrl+Alt+Down 

Increase point size (Увеличить размер кегля)  Ctrl+Shlft+. 

Increase point sizexS (Увеличить размер 

кегля на 5 ед.)  

Ctrl+Alt+Shitt+. 

Increase word space (Увеличить интервал 

между словами)  

Ctrt+Alt+\ 

Increase word spacexS (Увеличить 

интервал между словами на 5 ед.)  

Ctrl+Alt+Shift+\ 

Load Find and Find Next instance 

(Загрузить выделенный текст в поле Find 

и найти следующий пример) 

Shift+F1 

Load Find with selected text (Загрузить 

выделенный тест в поле Find) 

Ctrl+F1 

Load Replace with selected text (Загрузить 

выделенный тест в поле Replace)  

Ctrl+F2 

Move Down (Переход на одну ячейку вниз)  Down 

Move down one line (Переход вниз на 

одну строку)  
Down 

Move Left (Переход на одну ячейку влево) Left 

Move Right (Переход на одну ячейку вправо)  Right 

Move to beginning of story (Переход в 

начало текстового блока) 

Ctrl+Home 

Move to end of story (Переход в конец 

текстового блока)  

Ctrl+End 
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Move to First Cell in Column (Переход к 

первой ячейке столбца)  

Alt+PageUp 

Move to First Cell in Row (Переход к 

первой ячейке строки)  

Alt+Home 

Move to First Row in Frame (Переход к 

первой строке фрейма)  

PageUp 

Move to Last Cell in Column (Переход к 

последней ячейке столбца)  

Alt+Page Down 

Move to Last Cell in Row (Переход к 

последней ячейке строки)  

Alt+End 

Move to Last Row in Frame (Переход к 

последней строке фрейма)  

PageDown 

Move to Next Cell (Переход к следующей 

ячейке)  
Tab 

Move to Previous Cell (Переход к 

предыдущей ячейке)  
Shift+Tab 

Move to the end of the line (Переход в 

конец строки)  
End 

Move to the left one character (Переход на 

один символ влево)  

Left 

Move to the left one word (Переход на 

одно слово влево)  

Ctrl+Left 

Move to the next paragraph (Переход к 

следующему абзацу)  

Ctrl+Down 

Move to the previous paragraph (Переход к 

предыдущему абзацу)  

Ctrl+Up 

Move to the right one character (Переход 

на один символ вправо)  

Right 
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Move to the right one word (Переход на 

одно слово вправо)  

Ctrl+Rlght 

Move to the start of the line (Переход в 

начало строки) 
Home 

Move Up (Переход на одну ячейку вверх)  Up 

Move up one line (Переход на одну строку 

вверх)  
Up 

Normal horizontal text scale (Нормальная 

ширина текста) 

Ctrl+Shift+X 

Normal vertical text scale (Нормальная 

высота текста) 
Ctrl+Alt+Shift+X 

Recompose all stories (Перекомпоновать 

все текстовые блоки)  

Ctrl+Alt+/ 

Replace with Change To text (Заменить 

текстом из поля Change To)  

Ctrl+F3 

Reset kerning and tracking (Отменить 

настройки кернинга и трекинга) 

Ctrl+Alt+Q 

Select Cells Above (Выделить ячейки выше)  Shift+Up 

Select Cells Below (Выделить ячейки ниже) Shift+Down 

Select Cells to the Left (Выделить ячейки 

слева)  
Shift+Left 

Select Cells to the Right (Выделить ячейки 

справа) 
Shift+Right 

Select line (Выделить строку)  Ctrt+Shift+\ 

Select one character to the left (Выделить 

символ слева)  

Shifl+Left 

Select one character to the right (Выделить 

символ справа)  

Shift+Righ 
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Select one line above (Выделить строку 

выше)  
Shift+Up 

Select one line below (Выделить строку ниже)  Shift+Down 

Select one paragraph before (Выделить 

абзац выше)  
Ctrl+Shift+Up 

Select one paragraph forward (Выделить 

абзац ниже) 
Ctrl+Shift+Down 

Select one word to trie left (Выделить 

слово слева)  
Ctrl+Shift+Left 

Select one word to the right (Выделить 

слово справа) 
Ctrl+Shift+Right 

Select to beginning of story (Выделить до 

начала текстового блока) 

Ctrl+Shift+Home 

Select to end of story (Выделить до конца 

текстового блока)  

Ctrl+Shift+End 

Select to the end of the line (Выделить до 

конца строки)  

Shift+End 

Select to the start of the line (Выделить до 

начала строки)  

Shift+Home 

Toggle CelHext Selection (Переключение 

между выделением ячеек/текста) 

Esc 

Toggle Quotes preference (Переключение 

кавычек)  

Ctrl+Alt+Shift+V 

Update missing font list (Обновить список 

отсутствующих шрифтов)  

Ctrl+Alt+Shift+/ 

Символ 

Длинное тире  Ctrl + Shift + = 

Короткое тире Ctrl + = 

Фиксированный пробел Ctrl + Shift + H 
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Жесткий перенос строки  Shift + Enter  

Градус Alt + 0176  

Жирная точка (буллит) Ctrl + Shift + 8  

Знак авторского права Copyright  Ctrl + Shift + O  

Знак зарегистрированной торговой марки  Ctrl + Shift + G 

Знак торговой марки Alt + 0153 ™ 

Меню Window 

Align (Разместить объекты) F8 

Color (Цвет)  F6 

Hyperlinks (Гиперсвязи)  Shift+F7 

Index (Предметный указатель) Shift+F8 

Layers (Слои) F7 

Links (Связи)  Ctrl+Shirt+D 

Pages (Страницы)  F12 

Stroke (Линия)  F10 

Swatches (Образцы)  F5 

Table (Таблица)  Shift+F9 

TextWrap (Обтекание текстом)  Ctrl+Alt+W 

Transform (Преобразование)  F9 

Transparency (Прозрачность)  Shift+F10 

Меню Type 

Character (Шрифт) Ctrt+T 

Character Styles (Стили знака)  Shift+F11 

Check Spelling (Орфография)  Ctrt+l 

Create Outlines (Создать контуры)  Ctrl+Shift+0 
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Insert Column Break (Вставить символ 

начала новой колонки)  

Num+Enter 

Insert Forced Line Break (Вставить символ 

принудительного разрыва строки) 

Shift+Enter 

Insert Frame Break (Вставить символ 

начала нового фрейма)  

Shift+Num+Enter 

Insert Page Break (Вставить символ 

начала новой страницы)  

Ctrl+Num+Enter 

Insert Auto Page Number (Вставить 

символ автонумерации страниц)  

Ctrl+Alt+N 

Insert Bullet Character (Вставить символ 

маркированного списка (жирную точку))  

Alt+8 

Insert Copyright Symbol (Вставить знак 

авторского права)  

Alt+G 

Insert Discretionary Hyphen (Вставить 

дискреционный (мягкий) перенос)  

Ctri+Shift+- 

Insert Double Left Quotation (Вставить 

открытые двойные кавычки)  

Alt+[ 

Insert Double Right Quotation (Вставить 

закрытые двойные кавычки)  

Shlft+Alt+[ 

Insert Ellipsis (Вставить многоточие)  Alt+; 

Insert Em Dash (Вставить длинное тире)  Shift+Alt+- 

Insert En Dash (Вставить тире средней 

длины (короткое)) 

Alt+- 

Insert Indent to Here (Вставить символ 

величины отступа)  

Ctrl+\ 

Insert Next Page Number (Вставить номер 

следующей страницы)  

Ctrl+Alt+Shift+] 
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Insert Nonbreaking Hyphen (Вставить 

фиксированный дефис)  

Ctrl+Alt+- 

Insert Paragraph Symbol (Вставить символ 

абзаца)  

Alt+7 

Insert Previous Page Number (Вставить 

номер предыдущей страницы)  

Ctrl+Alt+Shift+[ 

Insert Registered Trademark Symbol 

(Вставить символ зарегистрированного 

товарного знака)  

Alt+R 

Insert Right Indent Tab (Вставить символ 

выравнивания по правому краю)  

Shift+Tab 

Insert Section Name (Вставить название 

параграфа)  

Ctrl+Alt+Shift+N 

Insert Section Symbol (Вставить символ 

параграфа)  

Alt+6 

Insert Single Left Quotation (Вставить 

открытые одиночные кавычки)  

Alt+] 

Insert Single Right Quotation (Вставить 

закрытые одиночные кавычки)  

Shift+AIt+] 

Insert Trademark Symbol (Вставить 

символ товарного знака)  

Alt+2 

Insert Em Space (Вставить круглую 

шпацию)  

Ctrl+Shift+M 

Insert En Space (Вставить полукруглую 

шпацию)  

Ctrl+Shift+N 

Insert Figure Space (Вставить цифровую 

шпацию)  

Ctrt+Alt+Shift+8 

Insert Hair Space (Вставить волосяную 

шпацию) 

Ctrl+Alt+Shift+l 
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Insert Nonbreaking Space (Вставить 

фиксированный пробел)  

Crl+Alt+X 

Insert Thin Space (Вставить тонкую 

шпацию)  

Ctrl+Alt+Shift+M 

Paragraph (Абзац)  Ctrl+M 

Paragraph Styles (Стили абзаца)  F11 

Show Hidden Characters (Показать 

непечатаемые символы)  

Ctrl+Alt+l 

Tabs (Табуляция)  Ctrl+Shift+T 

Меню View 

Display Master Items (Показать элементы 

шаблона)  
Ctrt+Y 

Entire Pasteboard (Отобразить монтажный 

стол)  
Ctrl+Alt+Shift+0 

Fit Page in Window (Отобразить всю 

страницу)  
Ctrl+0 

Fit Spread in Window (Отобразить 

разворот)  
Ctrl+Alt+0 

Hide Guides (Спрятать направляющие) Ctrl+; 

Hide Rulers (Спрятать линейки)  Ctrl+R 

High Quality Display (Отображение 

графики с высоким разрешением)  

Ctrl+Alt+H 

Lock Guides (Закрепить направляющие)  Ctrl+Alt+; 

Optimized Display (Отображение графики 

в виде плашек)  

Ctrt+Alt+O 

Show Baseline Grid (Показать базовую 

сетку)  
Ctrl+Alt+' 
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Show Document Grid (Показать сетку 

документа)  
Ctrl+' 

Show Frame Edges (Показать границы 

фрейма)  
Ctrl+H 

Show Text Threads (Показать линии 

связи)  
Ctrl+Alt+Y 

Snap to Document Grid (Привязать к сетке 

документа)  
Ctrl+Shift+V 

Snap to Guides (Выровнять по 

направляющим)  
Ctrl+Shift+; 

Typical Display (Стандартное отображение 

графики)  
Ctrl+Alt+Z 

Zoom In (Увеличить)  Ctrl+= 

Zoom Out (Уменьшить)  Ctrl - 

Инструменты 

Scale Tool (Масштабирование)  S 

Scissors Tool (Ножницы)  С 

Selection Tool (Черная стрелка)  V 

Shear Tool (Наклон)  0 

Swap fill and stroke activation 

(Переключение между пиктограммами 

фона и линии)  

X 

Swap fill and stroke colors (Переключение 

между цветами фона и линии)  

Shift+X 

Toggle Text and Object Control 

(Переключение между пиктограммами 

объекта и текста) 

J 
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Toggle view between default and preview 

(Переключение между обычным и 

предварительным просмотром)  

W 

Type Tool (Текст)  Т 

Zoom Tool (Масштаб)  Z 

Навигация 

200% size (Масштаб 200%) Ctrl+2 

Actual Size (Реальный размер)  Ctrl+1 

400% size (Масштаб 400%)  Ctrt+4 

50% size (Масштаб 50%)  Ctrl+5 

Access page number box (Перейти к меню 

выбора номера страницы)  

Ctrl+J 

Access zoom percentage box (Перейти к 

меню выбора масштаба)  

Ctrl+Alt+5 

Activate last-used field in palette 

(Активизировать поле палитры, 

задействованное в последний раз) 

Ctrl+~ 

First spread (Первый разворот)  Alt+Shift+PageUp 

Fit Selection in Window (Увеличить 

выделение до размеров окна) 

Ctrl+Alt+= 

Force redraw (Принудительнаяя 

перерисовка изображения)  

Shift+F5 

Go to first frame (Перейти к первому 

фрейму)  

Ctrl+Alt+Shift+Page

Up 

Go to last frame (Перейти к последнему 

фрейму)  

Ctrl+Alt+Shift+Page

Down 

Go to next frame (Перейти к следующему 

фрейму)  

Ctrl+Alt+PageDown 
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Go to previous frame (Перейти к 

предыдущему фрейму)  

Ctrl+Alt+PageUp 

Last spread (Последний разворот) Alt+Shift+PageDown 

Next spread (Следующий разворот)  Alt+PageDown, 

Ctrl+Right 

Next window (Следующее окно)  Ctrl+F6 

Previous spread (Предыдущий разворот)  
Alt+PageUp, 

Ctrl+Left 

Previous window (Предыдущее окно)  Ctrl+Shift+F6 

Scroll down one screen (Прокрутка вниз 

по высоте одного экрана)  

PageDown 

Scroll up one screen (Прокрутка вверх по 

высоте одного экрана)  

PageUp 

Show/Hide palettes (Отобразить/скрыть 

палитры)  

Tab 

Show/Hide palettes except toolbox 

(Отобразить/скрыть все палитры, кроме 

панелей инструментов)  

Shift+Tab 

Toggle between views (Переключение 

между режимами отображения)  

Ctrl+Alt+2 

Toggle Measurements (Переключение 

между единицами измерения)  

Ctrl+Aft+Shift+U 

Разное 

Add New Index Entry (Добавить вход 

указателя)  
Ctrl+Alt+U 

New index entry (reversed) (Добавить вход 

указателя (отмена)) 

Ctrl+Shift+F8 

Add New Page (Создать страницу)  Ctrl+Shift+P 
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Clear Local Display Settings (Сбросить 

локальные настройки экрана)  

Ctrl+Shift+F2 

Close all (Закрыть всѐ)  Ctrl+Alt+Shift+W 

Close document (Закрыть документ)  Ctrl+Shift+W 

Create outlines (Создать контуры)  Ctrl+Alt+Shift+0 

Decrease size/scale by 1% (Уменьшить 

размер/масштаб на 1%)  

Ctrl + 

Decrease size/scale by 5% (Уменьшить 

размер/масштаб на 5%)  

Ctrl+Alt + 

Increase size/scale by 1% (Увеличить 

размер/масштаб на 1%)  

Ctrl + 

Increase size/scale by 5% (Увеличить 

размер/масштаб на 5%)  

Ctrl+Alt + 

New default document (Новый документ 

по умолчанию)  

Ctrl+Alt+N 

Nudge down (Переместить вниз) Down 

Nudge down 1/10 (Переместить вниз на 

1/10 ед.)  
Ctrl+Shift+Down 

Nudge down 1/10 сору (Переместить вниз 

на 1/10 ед. и скопировать)  

Ctrl+Alt+Shift+Down 

Nudge down copy (Переместить вниз и 

скопировать)  
Alt+Down 

Nudge left (Переместить влево)  Left 

Nudge left 1/10 (Переместить влево на 

1/10 ед.)  
Ctrl+Shift+Left 

Nudge left 1/10 сору (Переместить влево 

на 1/10 ед. и скопировать)  

Ctrl+Alt+Shift+Left 

Nudge left copy (Переместить влево и 

скопировать)  
Alt+Left 
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Nudge left х10 (Переместить влево на 10 

ед.)  
Shift+Left 

Nudge left х10 copy (Переместить влево 

на 10 ед. и скопировать)  

Alt+Shift+Left 

Nudge right (Переместить вправо)  Right 

Nudge right 1/10 (Переместить вправо на 

1/10 ед.)  
Ctrl+Shift+Right 

Nudge right 1/10 сору (Переместить 

вправо на 1/10 ед. и скопировать)  

Ctrl+Alt+Shift+Right 

Nudge right copy (Переместить вправо и 

скопировать)  
Alt+Right 

Nudge right х10 (Переместить вправо на 

10 ед.)  
Shift+Right 

Nudge right х10 сору (Переместить 

вправо на 10 ед. и скопировать)  

Alt+Shift+Rignt 

Nudge up (Переместить вверх) Up 

Nudge up 1/10 (Переместить вверх на 

1/10 ед.)  
Ctrl+Shift+Up 

Nudge up 1/10 сору (Переместить вверх 

на 1/10 ед. и скопировать)  

Ctrl+Alt+Shift+Up 

Nudge up copy (Переместить вверх и 

скопировать)  
Alt+Up 

Nudge up х10 (Переместить вверх на 10 ед.)  Shift+Up 

Nudge up х10 сору (Переместить вверх на 

10 ед. и скопировать)  

Alt+Shift+Up 

Open index entry dialog (Открыть 

диалоговое окно входа указателя)  

Ctrl+U 

Save all (Сохранить все)  Ctrl+Alt+Shift+S 
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Select all guides (Выделить все 

направляющие)  
Ctrl+Alt+G 

Select bottom object (Выделить самый 

нижний объект)  

Ctrl+Alt+Shft+[ 

Select next object above (Выделить 

объект, расположенный выше)  

Ctrl+Alt+] 

Select next object below (Выделить 

объект, расположенный ниже)  

Ctrl+Alt+[ 

Select top object (Выделить самый 

верхний объект)  
Ctrl+Alt+Shift+] 

 

 

ПРИЛОЖЕНИЕ 2 

 

Контрольные вопросы по теоретическому и практическому 

курсу Adobe InDesign 

 

1. Какой инструмент позволяет создавать  текстовые фреймы 

и какой заполнять их? 

2. Какой символ показывает, что текстовый фрейм вмещает 

больше текста, чем может удержать вытесненный текст? 

3. Какой инструмент позволяет работать как с графикой, так 

и с фреймами? 

4. Какая палитра предоставляет возможности для изменения 

выделенных фреймов, графических объектов или текста? 

5. Какой инструмент позволяет редактировать текст? 

6. Где находится большинство инструментов для 

редактирования текста? 

7. Как называется команда поиска и замены? 
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8. Проверяя орфографию в документе, InDesign отмечает 

слова, которых нет в словаре, но многие из них на самом 

деле не содержат ошибок. Как можно решить эту 

проблему? 

9. Что можно сделать, если вы постоянно неправильно 

набираете какое-либо слово? 

10. Как увидеть базовую сетку? 

11. Когда и где используется табулятор правого обратного 

отступа? 

12. Как знаки препинания размещаются за пределами 

текстового фрейма? 

13. Как выровнять колонки? 

14. В чем разница между кернингом и трекингом? 

15. Каковы преимущества использования таблиц                    

по сравнению с набором текста и использованием 

табуляторов для разделения столбцов? 

16. Когда может возникнуть вытесненная  ячейка? 

17. Какой инструмент чаще всего используется при работе      

с таблицами? 

18. Как изменить цвет белых областей черно-белого 

изображения? Как изменить серые области? 

19. Как изменить эффекты прозрачности, не меняя значение 

Opacity (Непрозрачность) объекта? 

20. Насколько важен порядок наложения слоев и объектов на 

слоях при работе с прозрачностью? 

21. Применив эффект прозрачности к объекту, как легче всего 

применить его же к другому объекту? 
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22. Какие проблемы ищет InDesign при использовании 

палитры Preflight (Предпечатная проверка)? 

23. Какие элементы собирает InDesign при упаковке файла? 

24. Какие параметры можно выбрать, если вы хотите 

напечатать самую высококачественную версию 

отсканированного изображения на лазерном принтере или 

устройстве вывода низкого разрешения? 

25. Какие типы элементов можно добавить в веб-публикации 

из тех, что не работают в печатных публикациях? 

26. Как преобразовать объект в кнопку? 

27. Как можно узнать, как выглядит конкретный переход 

страницы? 

28. Как создать анимацию объекта? 

29. Опишите несколько способов изменения масштаба 

отображения документа. 

30. Как выбрать инструменты в программе InDesign? 

31. Опишите три способа отображения палитры. 

32. Как создать группу палитр? 
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